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ةً من مستخدمي برامج // أدوب // .. ة .. تحمل أسس و أخلاق المهنة .. تحيةً إعلانيَّ ة .. أخلاقيَّ ةً أخويَّ يَّ ةً فنِّ تحيَّ
ركة المنتجة لأشهر و أهمِّ برامج  ة .. مختلفةٌ عن كلمة // أدب // فأدوب هي الشَّ حيَّ و أدوب .. هنا .. في هذه التَّ

صميم الإعلانيّ .. التَّ
.. لرفع مستوى  المبتدئين  المحترفين و  مين  المصمِّ .. فيما بين  عاون  للتَّ ةٍ  .. تعدُّ بمثابة دعوةٍ إعلانيَّ تنا هذه  تحيَّ
ة // . عوة عامَّ ة .. و طبعاً // الدَّ صاميم الغربيَّ ة التَّ ة و واقعيَّ ة .. لترقى إلى حرفيَّ صميم الإعلانيِّ في البلاد العربيَّ التَّ
هات .. سنخبركم عن الاستفادة  وجُّ ة و سبل تطبيق تلك التَّ هات المجلَّ و قبل أن نبدأ بطرحٍ بسيط .. نعرض فيه توجُّ
ذي يعدُّ أهمَّ دوافع الإبداع في  نافس .. الَّ تي نسعى إليها من وراء ذلك .. و هي إيجاد مجالٍ أوسع و أفسح للتَّ الَّ
صة .. تفيد المبتدئين و المحترفين ؛ كلٌّ بحسب  أيِّ مجال .. و ذلك من خلال تبادل الخبرات عبر نشر مقالاتٍ متخصِّ
ة بأسماء أصحابها .. ليكون معرضاً  ة قسمٌ لعرض أعمالٍ نموذجيَّ درجة احترافه و معرفته .. و سيكون في المجلَّ

اعة .. دائماً لهم على مدار السَّ
صميم الإعلانيِّ و المطابع  ها ستصل إلى مكاتب التَّ ين .. حيث أنَّ مين الإعلانيِّ ة بمثابة إعلانٍ للمصمِّ ستكون المجلَّ

في البلاد .
صميم مثل )الفوتوشوب  ة لأهمِّ برامج التَّ ة .. كان لا بدَّ من طرح دروسٍ خاصَّ ة باسم الأخلاق المهنيَّ حيَّ نا بدأنا التَّ و لأنَّ

.. المراجعة  يحتاج  لمن  كمرجعٍ  لتكون  ؛  غيرها  و   ).... درو  _ الكوريل  _ الألّيستريتور 
م عناصر  روريِّ تخصيص بابٍ للحديث عن مواقع تقدِّ ه من الضَّ ة .. فقد وجدنا أنَّ عاون في المجلَّ و بغية تأكيد فكرة التَّ
ة من تلك المساعدات  ...( إضافةً إلى ما سنرفقه بالمجلَّ _ رموز  _ نقشات  صميم ) فيكتور  ة للتَّ انيَّ مساعدةٍ مجَّ

عديل .. ة قابلة للتَّ انيَّ حميل .. و أيضاً قوالب مجَّ لسهولة التَّ
ة .. فنراجع  يَّ ةٍ إن أمكن ، لمنتجٍ مطروحٍ في الاسواق المحلِّ طوير .. سنقوم بدراسة تحليليَّ قد للتَّ و لتفعيل فكرة النَّ
تصاميم  عارضين   .. مثلًا  ألبسةٍ  )كشركة  طويلة  ةٍ  زمنيَّ ةٍ  مدَّ خلال  الأسواق  في  طرحها  طرق  و  تصاميمه  ر  تطوُّ
راسة .. و طبعاً  ذي يطرح تلك الدِّ م الَّ ركة من زبائن المصمِّ من ...( شريطة أن تكون الشَّ رها عبر الزَّ أغلفتها و تطوُّ

ركة نفسها .. ة من الشَّ يَّ بعد الحصول على الموافقة الخطِّ
ة مجالٌ لإيضاح و إظهار أسرار و خفايا قد  د على فكرة تعميم الخبرة و الفائدة أكثر .. سيكون في المجلَّ و لكي نؤكِّ
ة إعدادها و  يِّ أو الكروم ....( كيفيَّ هبيِّ أو الفضِّ ون الذَّ مين . مثال )يسألونني عن اللَّ لا يعلمها البعض من المصمِّ

نسب الألوان فيها ..
قةٍ من المعرفة .. سنقوم بملاحقة أيِّ  ر الإعلانيَّ في العالم .. و كي لا نتقوقع في حدودٍ ضيِّ طوُّ ى نواكب التَّ و حتَّ

طةٍ عارضين الفروقات بينه و بين الإصدار القديم منه .. إصدارٍ جديدٍ لأيِّ برنامج .. و نشرحه بطريقةٍ مبسَّ
ةٌ هم من يعملون فيه عن  باعيّ .. و قلَّ حضير الطِّ م الإعلانيِّ ما لم يلقِ نظرةً على قسم التَّ لن تكتمل قدرة المصمِّ

معرفة ..
باعة بأغلب اشكالها )أوفست _ تيبو _ حراري ...( . صاميم للطِّ ات و التَّ سنحاول شرح أساليب و طرق تحضير الملفَّ

ر فيها ؛ حيث سيكون هناك قسم //  ة أو من حرَّ أكيد .. كلَّ من شارك في تصميم أعداد المجلَّ و لن ننسى بالتَّ
ة .. تعبيراً عن تقديرنا لجهودهم . تصميم العدد // ليكون بمثابة معرض لأعمالهم الخاصَّ

مٍ شهير .. نعرض أعماله و نستفيد جميعاً من خبراته إن  انٍ أو مصمِّ و سنحاول إجراء مقابلةٍ في كلِّ عدد ..مع فنَّ
شاء الله ..

.. للوصول إلى القدرة على  .. هو تطوير الجميع  تنا هذه  العائد علينا من مجلَّ بح  الرِّ تيجة و  النَّ لة و  .. المحصِّ ر  و نكرِّ
م أين هو  .. ليعرف المصمِّ ذي لن يكون بدون تبادل الخبرات و مقارنة الأعمال ببعضها  الَّ .. و  ريف  نافس الشَّ التَّ
ة عند هذه الحدود .. فالأبواب مفتوحةٌ أمام الجميع .. لتطوير هذه  ف المجلَّ صميم .. و طبعاً لن تتوقَّ من عالم التَّ
اقين في الإسهام  بَّ نا كنّا من السَّ ذين سنفخر يوماً ما .. أنَّ مين الَّ ة الهادفة إلى إنشاء جيلٍ مبدعٍ من المصمِّ المجلَّ

بإعدادهم .
ة الأولى في هذا المجال .. فإن وُجدت  نا المجلَّ ةٍ مماثلةٍ في الانترنت .. أعتقد بأنَّ انيَّ ةٍ مجَّ بعد بحثٍ طويل ، عن مجلَّ
ة الأولى في الوطن العربيّ .. بتوقيعٍ سوريّ .. و  زاً  لتكون المجلَّ ةٌ مماثلة ، فسنعمل على أن نكون الأكثر تميُّ مجلَّ

ق . الله الموفِّ

تحية من مجلة
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أعزائي القراء الكرام لا يسعني الا ان اشكركم  على ثقتكم بنا وعلى الفرصة التي منحتمونا 
اياها لكي نثبت لكم ان هذه المجلة ليست الا بوابة جديدة لكل المصممين الذين يمتهنون هذه 
المهنة ولكل الذين بطريقهم لكي يكونوا مصممين ان شاء الله، ان هذه المقالات الموجودة 
الثمينة حقيقة وقد تبدو للبعض كأنها  العلمية  المواد  الكثير من  المجلة فيها  بصفحات هذه 

تفاهات وليست الا مضيعة للوقت ولكن دعونا ننظر للموضوع بمنظور اخر...
نوعه  و  التصميم  تعليمية مفصلة حسب طبيعة  لسلاسل  بداية  الا  ليست  المقالات  ان هذه 

وقد غلب عليها الطابع الأكاديمي المبسط لكي تمتزج 
المعلومة الصحيحة مع الاسلوب السهل في التلقي ، و 
أصدقكم القول ... ان بعض هذه المقالات هي مقتبسة 
من مواقع و مدونات و منتديات مختصة في هذا المجال 
ولم اجد ما يمنع ان تكون هذه المقالات موجودة في 
هذه المجلة طالما تم ذكر المصدر و مرجع الاقتباس 
، فلسنا من اولئك الذين ينسبون اعمال غيرهم لهم 
و   ، افكار غيره  انه مصمم ويتبنى  ولسنا ممن يدعي 
يوجد ايضا بعض المقالات التي اجتهد بعض المحررين 
في انتاجها لتصل اليكم كمعلومة جاهزة قد اكون أول 
الأشخاص الذين بحثوا عبر محركات البحث مطولا لكي 
يحصلوا على جواب عن طريقة انجاز فكرة ما او اسلوب 

استخدام أداة معينة  .

أغلب  مقالاتنا  في  نغطي  ان  جاهدين  سنحاول 
استفساراتكم وتطلعاتكم في هذا البرنامج التعليمي 

ان شاء الله .

ان هذه المجلة و مقالاتها ليست حكرا لفريقها الحالي 
معنا  يشارك  ان  يريد  من  لكل  مفتوح  مجال  هي  بل 
بنشر مقالات من شأنها رفع المستوى الفني و التقني 

للمصممين في الوطن العربي كافة ان شاء الله .

كل ما يلزمك هو زيارة صغيرة الى مدونتنا المتواضعة 
و البدء بالمشاركة بمقالاتك .

عبر الرابط المؤقت الحالي :

www.creativesminds.wordpress.com

وسيتم تغيره قريبا جدا و ذلك بعد ان تم دمج أكثر من 
مدونة مختصة بأمور التصميم و أصبحت تحت عنوان 
Creative Minds  و سيتم اعلامكم بالعنوان الجديد 

قريبا ان شاء الله

البريد  عبر  مباشرة  المدونة  ادارة  مراسلة  يمكنك  او 
الالكتروني التالي :

creatives.minds11@gmail.com

وحرصا منا لأن تكون هذه المجلة أكثر شمولا ... قمنا 
ستحوي  التي  اليوتيوب  على  الخاصة  قناتنا  بإطلاق 
نكون  قد  ربما  التي  التعليمية  الفيديو  مقاطع  جميع 
انجزناها أو جلبناها لكم من مواقع اخرى وذلك لضيق 
الوقت و بغية اطلاق هذا المشروع بالسرعة القصوى 
و ستكون هذه القناة أيضا لكل أعضاء المدونة الكرام 
لكي يستخدموها كمرجع دائم لهم و بإمكانهم أيضا 
مدونتنا  نغني  لكي  عليها  الخاصة  فيديوهاتهم  رفع 
و   . الله  شاء  إن  ستلزمنا  التي  التعليمة  المواد  بكل 

بإمكانكم زيارة هذه القناة عبر الرابط التالي :

http://www.youtube.com/creativesminds11

قبل البداية ...
بقلم : محمد زرقة
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كل  فلها   ... أبدا  عملنا  في  الصورة  فضل  أنكر  لا  و 
انجاحه و لذلك قمنا بإنشاء حساب خاص  الفضل في 
على موقع فليكر العالمي الذي يعد أكبر موقع لتجمع 
كمستودع  المحطة  هذه  سنكون  و  العالم  في  الصور 
دائم لرواد المدونة و اعضائها لرفع صورهم على هذا 

الموقع و يكون لنا حيزنا الخاص عبر الرابط التالي :

http://www.flickr.com/photos/creativesminds

ولن أنسى صفحة المدونة على الموقع الأشهر عالميا 
أحدث  و  المدونة  أخبار  اخر  متابعة  بإمكانك  حيث 
و  صفحاتها  على  سنطرأ  التي  التعديلات  و  المقالات 
ذلك من خلال الرابط التالي الذي سيأخذك مباشرة الى 

صفحتنا على موقع الفايس بوك :

https://www.facebook.com/creativesminds

بامكانكم   ... ايضا  التويتر  موقع  ننسى  لن  طبعا 
متابعتنا ايضا على هذا الرابط :

https://twitter.com/CreativesMinds

و لحملة الهواتف النقالة الحديثة التي تستخدم نظامي 
قمنا   ) سيمبيان   ( الذكي  الهواتف  نظام  أو  الأندرويد 
تحديثات  و  امور  متابعة  مهمته  تطبيق خاص  بإنشاء 
هذه المدونة أول بأول.. و يمكنك من خلاله المشاركة 
على  كأنك  و  التعليق  و  التعديل  و  مقال  اضافة  و 
كما  خاصين  الاصدارين  هذين  و  الخاص.  حاسوبك 
و  الأندرويد  نظامي  على  تعمل  التي  بالاجهزة  ذكرت 
السيمبيان . و قريبا ان شاء الله سيكون هناك تطبيق 
بكافة   )   3g – 4g  ( الأيفون  أجهزة  لحملة  خاص 
اصداراتهم و يمكنك من خلال الروابط التالية تحميل 

التطبيق حسب نوع الموبايل الذي لديك :
     

و أخيرا و ليس اخرا ... لن تكون هذه الكلمة الأخيرة و 
لن نقف عند هذا الحد و انما نسعى دائما للمضي قدما 
يتوقف  هذا  و  ببلادنا  عام  بشكل  التصميم  لتطوير 
على سعيكم المتواصل معنا لتنفيذ ذلك ... مع فائق 

المودة و الاحترام
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Adobe Muse
لتصميم المواقع بدون برمجة

قامت شركة Adobe بإطلاق النسخه التجريبية من برنامج Adobe Muse وهو تطبيق جديد لتصميم المواقع عن 
طريق الانترنت دون الحاجة لإستخدام أكواد برمجية. يهدف التطبيق لإختصار تصميم المواقع دون المرور بين عدد 
من البرامج للوصول للموقع المراد تصميمه، أي دون الحاجة للإنتقال من تطبيق كالفوتوشوب لتصميم الموقع ثم 

لتطبيق آخر لبرمجة الأكواد له. 

التطبيق  أكواد خاصة بك في  التصميم وإضافة  يمكن 
بالـ    Adobe من  مصممة  جاهزة  إضافات  مع  نفسه، 

CSS3 و دعم كامل للـ jQuery
وكانت الشركة قد أطلقت هذه النسخة في: 2011-8-5.
مستنداً  تنشيء  كأنك  و  مواقعك  إنشاء  الآن  تستطيع 
 HTML تريد طباعته , مدعماً بأحدث معايير الويب بلغة
تُنشيء  أن  تستطيع  و   . كود  أي  كتابة  دون  الأصلية 
التجريبية  النسخة  مواقع مميزة جدا بل إحترافية هذه 

.Muse من
للمزيد من المعلومات توجه إلى المصدر

.]Adobe Muse[ 

و   sitemaps الموقع  خرائط  إستخدام  سهولة  إن 
خصائص  و   master pages الرئيسية  الصفحات 
تجعل   Site-wide properties الموقع  مستوى 
تخطيط موقعك سهلًا و سريعاً و جاهزاً للتصميم.

على  ليس  و  التصميم  على   Muse برنامج  يركز 
و  الصور  عرض  بين  يجمع  فهو  التكنولوجيا. 
الكامل  التحكم  و  النصوص  دقة  و  الرسومات 
بالتصميم و التي كنت تتوقع أن تنجزه جميع أدوات 

Adobe  للتصميم .

يمكنك إنشاء تخطيطات بشكل بديهي باستخدام 
و   )smart guides( الذكية  الأدلة  أدوات  من  كل 
وتحرير   ،)paste in place( المكان   في  لصق 
و   )columns( والأعمدة   )edit original( الأصلي 
الأدوات  من  الكثير  الكثير  و   ،)gutters( المزاريب 

المألوفة.
السهلة  الموقع  بخريطة  موقعك  صفحات  رتب 
بنية  وتغيير  بإنشاء  لك  تسمح  التي  الاستخدام 

الموقع بسرعة.

تحدد و تتحكم بالعناصر التي تظهر في الصفحات 
التي تشترك معها بحيث تُضاف هذه العناصر في 
أية عناصر يتم  أن  الرئيسية.أي  الصفحة  تخطيط 
في  عرضها  سيتم  الرئيسية  الصفحة  في  وضعها 

كل الصفحات التي تم ربطها بهذه الصفحة.
صفحة  من  أكثر  هنالك  يكون  أن  الممكن  من 

رئيسية واحدة.

تحدد أساسيات التخطيط التي يتم تطبيقها خلال 
الموقع تلقائيا، مثل الهوامش ، وعرض الصفحة، 

والمحاذاة ، وألوان الارتباط التشعبي.

 ميزات البرنامج:
خطط موقعك:

صمم موقعك بحرية تامة:

أدوات Adobe المألوفة :

:Sitemaps  خرائط الموقع

:Master Pages  الصفحات الرئيسية

 Site-wide الموقع  )عرض(  مستوى  خصائص 
properties

بقلم : نسمة قطان
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Adobe Muse
لتصميم المواقع بدون برمجة

.Muse الموقع الرسمي للتطبيق مصمم بشكل كامل بواسطة •
• الصفحة الشخصية لـ Christina Warren )محررة في Mashable ( فقط بـ20 دقيقه بواسطة التطبيق.

نتائج التطبيق رائعة ويستحق التجربة كونه يوفر الكثير من الوقت،كما أنه يدعم اللغه العربية.

برنامج Muse مجاني خلال الفترة التجريبية )نسخته البيتا(
و النسخة الأولى من ميوز سيتم إنتاجها في بدايات العام 2012 و سيمكن هذا العملاء من شراء النسخة كي 

. Muse يتمكنوا من الإستمرا في ترخيص مواقعهم المصممة بواسطة
Muse سيكون متاحا بالإشتراك السنوي أو الشهري , مما سيمكن العملاء من الحصول على أحدث الإضافات و 

المميزات التي تكون متوافقة مع أحدث المتصفحات.

سنوي= $15 في الشهر = $180 في السنة )لا تستطيع إيقاف الإشتراك(.
شهري = $20 في الشهر .

 يتم إنهاء الإشتراك بعد 6 أشهر إذا لم يقم الزبون بتسديد المبالغ خلال هذه الفترة.

نتائج التطبيق رائعه جداً ..  مثلًا 

خطط الإشتراك :
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أفضل 50 نصيحة
في استخدام برنامج الفوتوشوب

و  العالم  الفوتوشوب حول  أغلب خبراء  والتي أجمع عليها  الفوتوشوب  50 نصيحة في برنامج  سأقدم لكم أفضل 
منها قديمة و منها جديدة و منها خاصة بالإصدار  ) CS5 ( و فعلا إن هذه النصائح البسيطة تسرّع إبداعاتك وتزيد 
 Adobe Photo Shop CS5 ( إنتاجك الفني و تسهل العمل على البرنامج , لذلك استرح قليلا ، قم بتشغيل برنامج

Me ( و لاتنسى أن تجلب كوب بارد من الحليب و استعد لحرارة الملاحظات القادمة :

للطبقة  المصغرة  الصورة  على  مزدوجة  نقرة 
النصيةThumbnail   في قائمة / Layers / ثم من 
الخط  اسم  نظلل  البرنامج  أعلى  الخيارات  شريط 
المستخدم و اضغط على الاسهم العلوي أو السفلي 
في لوحة المفاتيح لتغيير الخط و مشاهدته مباشرة 

على الملف مباشرة 

قم بتحديد كامل النص و ذلك بالنقر نقرة مزدوجة 
   Thumbnailعلى الصورة المصغرة للطبقة النصية
في قائمة / Layers / ثم قم بالضغط على زر / 
للقيام  يسار  أو  يمين  الأسهم  استخدم  ثم   /  Alt
بأجراء تباعد بين جميع الأحرف في هذه الطبقة و 
تسمى هذه العملية بـ  / Tracking  /. و في حال 
من  يتألف  عليه  تعمل  الذي  النصي  المقطع  كان 
السابقة  الطريقة  أكثر من سطر فنستخدم نفس 
أو  لزيادة  السفلي  أو  العلوي  الأسهم  استخدام  مع 
إنقاص المسافة بين الأسطر و تسمى هذه العملية 
بـ  / Leading  /. وفي حال أردنا أن نبعد حرفين 
عن بعضهما فقط دون التأثير على باقي الكلمات 
في هذه الطبقة نضع المشيرة بين الحرفين المراد 
الإبعاد بينهما  و نستخدم  زر / Alt / ثم نستخدم 
و  التباعد  بأجراء  للقيام  يسار  أو  يمين  الأسهم 

./   Kerning /  تسمى هذه العملية بـ

تعمل  لا  الفوتوشوب  برنامج  في  الميزات  بعض 
يفرض  مما   ، الفلاتر  مثل  النصية  الطبقة  على 
علينا تغير نوع الطبقة النصية لطبقة عادية عبر 
النصية  الطبقة  بفقد  مما   /    Rasterize  / أمر 
معه  التعامل  و  الخط  حجم  و  نوع  تغيير  إمكانية 

1 - تبديل مع مشاهدة  نوع الخط :

2 - تباعد الأحرف و الأسطر و الكلمات  :

3 - ابقاء العنصر النصي قابل للتعديل من خلال      
العنصر الذكي :

 Smart كطبقة نصية ، ببساطة حول الطبقة لعنصر ذكي
 Layer > Smart Object > Convert ( من خلال   Object

)  to Smart Object
الفلاتر كفلاتر ذكية على  بإمكانك تطبيق  الآن أصبح  و 
الطبقة المحولة و في حال أردت إجراء أي تعديل نصي على 
الطبقة فقط قم بالنقر على الطبقة نقرا مزدوجا سيحرر 
لك العنصر و يجعله قابلا للتعديل ، قم بالتعديلات التي 
على  التعديلات  تطبيق   سيتم  و  الملف  أغلق  و  تريدها 

الطبقة المذكورة 

بقلم : محمد زرقة
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أفضل 50 نصيحة
في استخدام برنامج الفوتوشوب

ان ميزة Opentype  متوفرة في القائمة الفرعية 
لنافذة الخطوط الموجودة على شريط الخصائص 

. ) Window > Character ( يمكن ببساطة إضافة أي نص على مسار أو شكل لأداة النصوص أو
)shape( قم بإنشاء المسار الذي تريده باستخدام 
أداة الـ Pen Tool  ثم ببساطة ضع مؤشر الماوس 
بعد اختيار أداة النصوص على المسار المطلوب و 

اكتب الكلمة التي تريد. 

من قائمة Edit اذهب إلى Preset Manager احذف 
بعدها  قم  و  تريدها  التي  الفرش  رتب  و  عدل  و 

بحفظ مجموعة الفرش التي تريدها فقط .

عندما تكون تستخدم أداة الأنشوطة ) Lasso ( أو 
أي أدارة رسم كالفرشاة يمكنك بالضغط على زر 
Caps Lock  الموجود على لوحة المفاتيح لتغيير 
من  يمكنك  مما  نوعها  حسب  الأداة  عرض  شكل 
عرض حجم الفرشاة لتستطيع تقدير الحجم المراد 

استخدامه .

جلبه  و  صورة  من  ما  عنصر  بتحديد  تقوم  عندما 
إلى ملف آخر قد تحتوي  أطراف العنصر على نقاط 
فنقوم   ... المصدر  الملف  حسب  سوداء  أو  بيضاء 
باستخدام أداة Dodge  لتفتيح الأطراف و بإمكانك 
جعل التأثير على الإنارة فقط أو على الظلال فقط 
أو على العنصر بشكل عام و ذلك من خلال شريط 
 Shadows  : المستويات  أحد  اختيار  و  الخصائص 
أداة  باستخدام  و  طبعا   – Highlight – Midtones
Brun سيمكنك من تعتيم أطراف العنصر بعكس 

.Dodge أداة

أو  كإمالتها   ( النصية  الطبقة  شكل  تغيير  يمكن 
   Text Warp تقويسها أو .... ( و ذلك عن طريق أمر

الموجود على شريط الخصائص لأداة النص. 

الحروف  بعض  شكل  تغير  الميزة  هذه  تمكن 
للخطوط التي تدعم هذه الميزة , فقط قم بتحديد 

الكلمة أو جزء منها و اختر النمط التي تفضله .

4 - نمط Opentype  مع الخطوط الرائع :

6 - تشكيل النص على مسار :

7 - اصنع قائمة الفرش Brush's الخاصة بك :

8 - شاهد شكل أداة التحديد و مساحة الرسم :

9 - استخدم أداوات Dodge / Burn   لتحسين 
أطراف التحديد :

5 - إمالة أو تغير شكل الكتابة :
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أفضل 50 نصيحة
في استخدام برنامج الفوتوشوب

عندما تقوم بتحديد حول عنصر و تقوم بنسخه و 
لصقه بملف آخر , تمكنك أداة Blur من كسر أطراف 
التحديد و اضفاء نعومة عليه و ذلك من خلال تمرير 
هذه الاداة على اطراف العنصر و بإمكانك التحكم 
بمدى التأثير من خلال Strength   الموجود على 

شريط الخصائص بالنسبة المئوية .

قد  ملف  أي  على  جديد  عنصر  نسخ  اضافة  بعد 
يكون هناك خلاف في مستوى النصوع بينه و بين 
الملف الجديد ، فيمكنك تخفيف أو أضافة النصوع 

على العنصر الجديد من خلال : 
) Layer > New Adjustment Layer > Hue 
Saturation ( 
و من المزلاج الخاص بـ Saturation  يمكنك إضافة 

أو تخفيض النصوع بما يتلائم مع الملف الجديد .

هل تعلم أنه بإمكانك تحديد أكثر من مصدر لأداة 
الاستنساخ Clone Stamp  ؟ نعم بكل بساطة من 
 Window >  ( الأداة  بهذه  الخاصة  النافذة  خلال 
Clone Source ( يمكنك إضافة خمسة مصادر من 
خمسة ملفات أو حتى من خمسة مصادر من ملف 
و  الثاني  و  وحدده  الأول  المصدر  اختار  واحد فقط 
حدده و هكذا .. و ببساطة إطلب المصدر المطلوب 

من خلال النقر عليه لاحقا .

) Flip ( يمكنك باستخدام هذا الخيار قلب المصدر
يعني عندما نختار المصدر سيقوم البرنامج بنسخه 
الطلب  حسب  أفقيا  أو  عاموديا  أما  معكوسا  لكن 
الدائري  السهم  على  الضغط  خلال  من  ذلك  و 
  W Clone Source أما الأفقي  الموجود في نافذة 

 .. H أو العمودي

10 - إماهة أطراف التحديد :

الجديد على  العنصر  ألوان  التناغم   - إضافة   11
الصورة الجديدة  : 

 Clone  ( لأداة  مصدر  من  أكثر  تحديد   -  12
: ) Stamp Tool

 Clone Stamp (  13 - عكس المصدر في أداة
:)Tool
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أفضل 50 نصيحة
في استخدام برنامج الفوتوشوب

بعد كتابة أي طبقة نصية يمكنك رسم مسار حول 
مع  مسار  إلى  العنصر  تحويل  بالأحرى  أو  الكتابة 
خلال  من  وذلك  النصية  الطبقة  على  المحافظة 
النصية  الطبقة  على  اليمين  الماوس  بزر  الضغط 
 Create Work Path اختيار  و    Layer قائمة  في 
سيقوم البرنامج برسم مسار حول الطبقة النصية 

مع المحافظة على الطبقة النصية .

حالة  غير  تحوي  لا  قد   )  Fonts  ( الخطوط  أغلب 
واحدة و هي الحالة الافتراضية و قد يعجبك أحدها 
و لكنه بحاجة تعريض و الخط لا يحوي هذه الحالة 
بتحديد  قم  أولا  التالية  بالطريقة  الحل  فيكمن 
 Windows > (  الخط و من القائمة الفرعية لنافذة

.) Faux Bold (  اطلب خيار ) Character

من الأوامر القوية جدا في هذا البرنامج الرائع التي 
المفتوحة  الملفات  مع  التعامل  تسهيل  شأنها  من 
و  ملفات  عدة  فتح  تريد  فلربما  البرنامج  ضمن 
الى  التوجه  سوا  عليك  فما  واحد  ملف  في  جمعها 
 File > Scripts > Load Files Into  (   : قائمة 
لك مربع حوار قم من خلاله  …( سيظهر   Stack
باستدعاء الملفات المطلوب جمعها في ملف واحد 
ثم   ) Ok (و سيقوم البرنامج بفتح اللفات جميعها 
حسب  الملف  حجم  ملائمة  و  واحد  بملف  ووضعها 

قياس أكبر صورة مطلوبة .

و  الطبقات  نسخة من جميع  أخذ  بحاجة  تكون  قد 
الضغط  سوا  عليك  فما  واحدة  طبقة  في  دمجها 
على   ) Shift + Alt + Ctrl + E (سيقوم البرنامج 
بأخذ نسخة من جميع الطبقات و دمجها في طبقة 
هذه  أن  الوحيدة  المشكلة  لكن   . مستقلة  جديدة 
الحل  لكن  و  بعد  فيما  للتعديل  قابلة  الطبقة غير 

يكمن بالخطوة القادمة 

الذي   Gif امتداد  غير  هناك  يكن  لم  الماضي  في 
التي فيها مساحات  لنا بالتعامل مع الصور  يسمح 
   Png امتداد  باستخدام  فبإمكانك  الآن  أما  شفافة 
التنويع  و  الشفافة  المساحات  مع  التعامل  من 

. Alpha بدرجات الشفافية التي تسمى

في  جديدة  طبقة  إدراج  عند  عليه  المتعارف  من 
و   ، حاليا  المختارة  الطبقة  فوق  تنزل  الفوتوشوب 
لكن إن أردنا أن ندرج الطبقة مباشرة تحت الطبقة 
Ctrl    بالتزامن  المختارة فما علينا إلا أن نضغط 
مع الضغط على أيقونة طبقة جديدة الموجودة في 

. Layers قائمة

البرنامج  اعدادات  استعادة  لحظة  بأي  يمكنك 
و  البرنامج  تنصيب  بعد  كانت  مثلما  الافتراضية 
يتم ذلك بالضغط على ) Ctrl+Alt+Shift (  و قم 
بتشغيل البرنامج بنفس الوقت ستظهر لك رسالة 
تطلب منك التأكيد ، في حال التأكيد سيتم ارجاع 

البرنامج كما كان.

مع  يتعامل  عندما  الفلتر  هذا  أن  الملاحظ  من 
على  سلبا  يؤثر  الكبيرة  الأحجام  ذات  الملفات 
سرعة و أداء البرنامج و قد يرسل لك رسالة بحاجة 
البرنامج الى ذواكر أو حتى أنها غير كافية لتشغيل 
الفلتر ، يكمن الحل بتحديد المنطقة المراد تطبيق 
الفلتر عليها فقط و تشغيل الفلتر مما يسهل على 

البرنامج التعامل مع هكذا أحجام .

14 -  تحويل الطبقة النصية إلى مسار :

لا  التي  للخطوط  المزيف   )  Bold  ( نمط   -  19
تحوي هذا النمط :

20 - فتح عدة ملفات في ملف واحد :

طبقة  في  الطبقات  جميع  دمج  و  نسخة   -  21
واحدة :

التي  للملفات   PNG إمتدادات   استخدم   -  15
تحتوي شفافية :

16 - إنشاء طبقة تحت طبقة :

كما  الفوتوشوب  تفضيلات  جميع  إرجاع   -  17
كانت ) ضبط المصنع ( :

18 - فلتر ) Liquify  ( على الملفات ذات الأحجام 
الكبيرة :
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أفضل 50 نصيحة
في استخدام برنامج الفوتوشوب

كنتيجة  السابقة  للخطوة  مشابهة  الخطوة  هذه 
تكمن  حيث  بالمضمون  جدا  كبير  فرق  مع  ولكن 
الفكرة في إمكانية إجراء التعديلات على مضمون 
هذه الطبقة المدموجة و تكون بالطريقة التالية : 
قم بتحديد جميع الطبقات و حولهم لعنصر ذكي :
  ) Layer > Smart Object > Convert To 
Smart Object ( 
تحويلها  و  الطبقات  جميع  بدمج  البرنامج  سيقوم 

لعنصر ذكي .
أو  التعديلات  إجراء  .. فكيف سأتمكن من  الأن  أما 
بالنقر  قم  ببساطة  و  ؟  طبقاتي  سأسترجع  كيف 
البرنامج بفتح  الذكي فيقوم  العنصر  مرتين على 
تريد  ما  عدل   ... الأصلية  بطبقاته  جديد  ملف 
أن  ستلاحظ  الحفظ  على  وافق  و  الملف  أغلق  و 
التعديلات  حسب  محتواه  تغير  قد  الذكي  العنصر 

التي قمت بها .

قد يكون عنوان الفقرة غريب قليلا و لكنه صحيح فاذا كان لديك صورة لمنظر ما و يوجد فيها سلك كهرباء 
فبإمكاننا إزالته ببساطة باستخدام أداة Spot Healing Tool   ولكنني سأنصحك بطريقة أفضل و ذلك : قم 
برسم مسار باستخدام أداة Pen Tool فوق السلك المراد إزالته و اذهب إلة نافذة :  ) Window > Paths (  و من 
القائمة الفرعية اختر ) Stroke Path  ( و من القائمة المنسدلة للأدوات اختر أداة  ) Spot Healing Brush (   و 

وافق ... و لاحظ النتيجة بنفسك .

إن إصدار  CS5  هو أول إصدار يسمح لك بتعيين 
 ( ذلك عن طريق  و  الألوان  إختيار  لنافذة  إختصار 

 ) Edit > Keyboard Shortcuts
إنزل  و    )  Tools  ( اختر  المنسدلة  القائمة  من  و 
قم  و   )  Foreground Color Picker  ( لتختار 
كان  حال  في  و   ، يناسبك  الذي  الاختصار  بتعيين 
الاختصار الذي قمت باختياره مختار سابقا سينذرك 
البرنامج بوجوده و سيخبرك لأي أمر مستخدم ففي 
حال وافقت سيستبدل الاختصار القديم و سيأخذك 

للقديم إن أردت استبداله أو تجاهله .

عليها  التعديل  إمكانية  مع  الطبقات  دمج   -  22
فيما بعد  :

Healing - 24  باستخدام المسار   :

23 - إنشاء إختصار لنافذة اختيار الألوان : 



14 www.creativesminds.wordpress.comMay  - 2012  العودة إلى فهرس المجلة

الحجم لعنصر كنت قد عدلت حجمه مباشرة فما  إعادة تحجيم عنصر ما بنفس معدل تغير  قد تكون بحاجة 
 Free Transform : Ctrl + ( عليك سوا إجراء التعديلات المطلوبة لحجم العنصر الأول باستخدام التحويل الحر
T ( و بعدها اختر الطبقة التالية المراد اجراء نفس التعديلات عليها و اضغط على ) Ctrl + Shift + T ( سيقوم 

الفوتوشوب بإعادة تحجيم هذا العنصر بنفس النسب السابقة .

هذه  من  الثاني  الجزء  عن  القادم  العدد  في  سنتكلم  و  المهمة  الملاحظات  هذه  من  الأول  الجزء  لكم  قدمت 
الملاحظات و اتمنى أن تساهم و تساعدكم في تطوير مهاراتكم في استخدام برنامج الفوتوشوب .

 لقائنا في العدد القادم إن شاء الله .

25 - تغيير الحجم مرة أخرى بنفس المعدل :

أفضل 50 نصيحة
في استخدام برنامج الفوتوشوب
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http://www.networkset.net/
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ميزات وخفايا
Adobe Photoshop CS5

أصدرت شركة ادوبي مجموعة الـــCS5  التي تحوي على معنى الابداع بين طياتها.
Adobe Photoshop CS5 الذي اعتبره الكثيرون طفرة في عالم  وسنقوم  في هذا المقال بشرح ميزات برنامج 
التصميم سهلت للمصممين الكثير من أعمالهم لما احتوت من خصائص متقدمة كنا نبذل مجهوداً كبيراً في تنفيذها.

مسح الخلفيات أصبح الآن أسهل بكثير فيمكنك الآن عمل الماسك والتحديدات الدقيقة بسرعة هائلة.
فمثلا اذا كان لديك شخص تريد استخراجه من الخلفيه فيمكنك استخراجه بسهولة وحتى لو كان شعره صعب 

التحديد ..

فهي  الجديدة  المميزات  أفضل  احد  هي  هذه 
وهي  الصور  لمعالجة  تستخدم  جديدة  أداة 
ولكن   Healing Brush Tool لأداة  مشابهة 
وفيها  صورة  لدينا  كان  لو  مثلا  بكثير  أفضل 
واستخدام  الشجر  بتحديد  مثلا  نقوم  شجر 
الشجر كاملا دون تشويه  الأداة فتقوم بحذف 
في  الموجودة  السماء  صورة  فتظهر  المنطقة 
واقعية  وتبدو  الشجرة  مكان  وتأتي  الصورة 

%100 فهي أداة فعلا سحرية.

1 -  التحديدات المعقدة أصبحت أسهل بكثير :

: )Content aware Fill( 2 - أداة تعبئة المحتوى

بقلم : نسمة قطان
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بسبب تعرض الصورة لعدة أخطاء يمكننا الجمع بينها في مجموعة واحدة ديناميكية عالية )HDR( التي تحافظ 
على دقة المشهد أو الصورة ومن التعديلات أنه اصبح هناك صلاحية لتحكم أكبر بعملية الدمج ومزيد من 

التحكم في التصميم ويمكن ان تكون النتيجة واقعية أكثر من قبل والصورة التالية توضح ذلك

هي ميزة جديدة تسمح لك باختيار عدة ألوان 
البعض ببعض  وخلطهم دمجهم مع بعضهم 
الإعدادات تحقق بذلك نتائج رائعة قريبة من 

التلوين العادي أو المائي
الصورة توضح ذلك .. 

: HDR 3 -  تعديلات في تقنية

: )Mixer Brush( 4 - فرشاة الخلط

ميزات وخفايا
Adobe Photoshop CS5
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العناصر في أي  الخاصية فعلا رهيبة فهي مشابهة لخاصية Transform فهي تسمح لك بدفع وسحب  هذه 
صورة بحيث تضع عدة نقاط على المنطقة التي تريد تحريكها ثم ببساطة تحركها الى أي منطقة تريدها .. 

والصورة التالية توضح ذلك ..

لتحويل  جداً  مهم  الخاصية  وهذه  الأبعاد  ثلاثية  الى  الأبعاد  الثنائية  أعمالك  تحويل  بسهولة  يمكنك  الآن 
نصوصك الى شعارات أو الى أعمال فنية و الصور توضح هذه الخاصية .. 

: Puppet Warp 5 -  خاصية

: 3D 6 - اخراج العمل الى

ميزات وخفايا
Adobe Photoshop CS5
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الفوتوشوب CS5 محمل بمكتبة من مجسمات 3D جاهزة والكثير من الإعدادات لها لتحسن أعمالك الثلاثية 
الأبعاد كما يمكنك تحميل المزيد من النت أو حتى تنشىء المجسمات بنفسك ..

7 -  تحسين وزيادة الواقعية في الثري دي :
ميزات وخفايا

Adobe Photoshop CS5
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أنواع العدسات
شهدت صناعة العدسات تطورا كميا ونوعيا الأمر الذي طور من استخدامات مختلف أنواع الكاميرات حيث نشير هنا 

إلى:
1- أهم أنواع العدسات

2- نظام العدسات وأداء الكاميرا
3 - البعد البؤري وزاوية العدسة

4- أهم العدسات العادية الشائعة الاستخدام                                                       
5- العدسة طويلة البعد البؤري )ضيقة الزاوية(

6-العدسات المتكاملة )المقربة(
7- العدسة الزوم

8- التركيز البؤري وعمقا لميدان
9- فتحة العدسة  

10-  العدسة طويلة البعد البؤري )ضيقة الزاوية(

على  الأمر  واقع  في  الكاميرا  عدسات  اصطلاح  يطلق 
الكاميرا،ويتراوح  في  توجد  التي  العدسات  مجموعة 
عددها عادةً بين ثلاث أو أربع عدسات، تتميز كل منها 
بخصائص معينة وتثبت داخل صمام الكاميرا، لتعمل 
يوجد  خاص  وتناسق  ترتيب  في  الأخرى  العناصر  مع 
قدر  بأقصى  العمل  متطلبات  تلبية  لها  ويكفل  بينها، 
للعدسة  الأساسية  الوظيفة  فإن  والكفاءة.  الدقة  من 
هي أنها تعكس صور صغيرة شديدة الوضوح للمنظر 
الذي أمامها، وتركزه فوق صمام )أو صمامات( الكاميرا.
العدسة  هما  العدسات  من  رئيسان  نوعان  وهناك 
منها  كل  تختلف  )والتي  الثابت  البؤري  البعد  ذات 
اختلافاً  الأخرى  عن 
التركيز  حسب  تاماً 
الذي  البؤري  والبعد 
على  منها  كل  تصمم 
أساسه( تناسب معظم 
التصوير  كاميرات 
 ، في ا غر تو لفو ا
التصوير  وكاميرات 
 ، في ا غر تو لفو ا
التصوير  وكاميرات 
وتلك  التصميم،  البسيطة  والتلفزيوني  السينمائي 

بقرص  المزودة 
الدوار،  العدسات 
يتحرك  قرص  وهو 
فيتم  دائرياً 
من  بذلك  الانتقال 
أخرى.  إلى  عدسة 
ذلك  إلى  وبالإضافة 
هذا  تصميم  فإن 
العدسات  من  النوع 

ذات البعد البؤري الثابت جعل منها أنسب العدسات التي 
يمكن بواسطتها تغطية المشهد من جوانبه المختلفة، 
وإن كانت العدسة الزوم تمتاز هي الأخرى بأنها تحقق 

تنوعاً في الرؤية )المنظر( عند تغطية لقطة ما.
إلى  أنتنقل  على  الصورة  قدرة  فإن  الحالات،  كل  وفي 
أو  الحجم  أو  الفراغ  أو  بالمسافة  الإحساس  المشاهد 
الحيز، إنما يتأثر تأثيراً مباشراً بزاوية الرؤيا للعدسة، أي 
الزاوية التي تنظر منها الكاميرا )العدسة( إلى المنظور 

أو الغرض الذي أمامها وحجم هذه الزاوية وطبيعتها.

:Camera Lens
أنواع العدسات:

بقلم : غادة عوامات
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أنواع العدسات

تكور في  ذات  الزجاج  عبارة عن قطعة من  العدسة 
الأشعة  في  انكساراً  تحدث  لكليها،  أو  أحد سطوحها 
والعدسات  وجهيها،  أحد  على  الساقطة  الضوئية 
شائعة الاستخدام العدسات محدبة ومقعرة، والعدسة 
المحدبة تستخدم لتجميع الأشعة الضوئية والعدسة 
المقعرة لتفريغ الأشعة الضوئية. والعدسة المحدبة 
أسمك في الوسط من العدسة المقعرة، بينما العدسة 
وقد  الوسط.  في  منها  الأطراف  في  أسمك  المقعرة 
العدسة  وهذه  لونية(،  )لا  أكروماتية  عدسة  أنتجت 

تستخدم في صنع الآلآت البصرية المختلفة.

تتميز بأنها تقدم العديد منا لأحجام للمنظر الواحد، 
الكاميرا  بين  تفصل  التي  المسافة  حسب  على 
والمنظور. ولذلك فإننا كلما احتجنا إلى منظر أكبر، 
يكون علينا أن نضع الكاميرا قرب المنظور، أو ننقل 

المنظور إلى مسافة أكثر قرباً من الكاميرا.

العدسة  لاختيار  أوسع  فرصاً  يحقق  نظام  وهو 
المناسبة، من بين عدة عدسات منذوات البعد البؤري 
الثابت )وكل منها تختلف عن الأخرى بطيعة الحال( 
للمنظر.  ومن ثم فإن كل منها تقدم رؤية مختلفة 
ويعرف هذا النظام أيضاً بأنه نظام »القرص الدوار 
تغيرت  كلما  المنظر  حجم  تغيير  ويتم  للعدسات« 
العدسة  تغيير  إلى  الإشارة  يجب  أنه  على  العدسة.. 
تكون  عندما  بل  الالتقاط،  أثناء  يجري  أن  يمكن  لا 
الكاميرا في حالة الاستعداد والإعداد للقطة )وتكون 

الكاميرا الأخرى هي التي تعمل في ذلك الوقت(.

الناحية  من  للعدسة  البؤري  البعد  تعريف  يمكن 
المركز  بين  الواقعة  »المسافة  بأنه  الاصطلاحية 
تكون  عندما  الكاميرا  صمام  ووجه  للعدسة  البصري 
الناحية  من  أما  اللانهاية«.  على  مضبوطة  العدسة 
العملية فيمكن القول بأن البعد البؤري للعدسة هو الذي 
يحدد مقدار ما نراه من المنظور وما وراءه من خلفيات. 
وبتعبير آخر يمكن القول بأن زاوية الرؤية للعدسة هي 
التي تحدد مقدار ما يظهر أمامنا على الشاشة، ويخضع 
ذلك لطول البعد البؤري خضوعاً تاماً. وعلى ذلك فإنه 
كلما زاد البعد البؤري للعدسة، قلت زاوية مجال الرؤية، 
كبر  المنظور  صغر  وكلما  المنظور،  يصغر  وبالتالي 
الجزء الذي نراه وبذلك نشعر أنه قريب منا )أي أنه كلما 

استخدمنا عدسة طويلة 
كلما شاهدنا جزءاً من المشهد أقل(، وفي هذا الصدد 
تقاس  كانت  وإن  العدسة  زاوية  أن  إلى  الإشارة  تجدر 
عادةً على المستوى الأفقي، فإن مجال الرؤية له أيضاً 

أبعاده الرأسية، وإذا رسمنا 
كل مجال الرؤية لإحدى العدسات، فإننا نكون قد رسمنا 
ما يشبه الهرم المقلوب، ومن ثم فإن أي أحداث تدور 
الحال.  الهرم لن تظهر في الصورة بطبيعة  خارج هذا 
ولذا يكون على المخرج أن يراعي الزاوية الرأسية عند 
تصميم الحركة داخل إطار الصورة، تفادياً لأي تحريف 
أو تشويه قد يبدو في المستويات الرأسية كما يبدو في 

المستويات الأفقية، وفي المواقف التي تبدو 
زاوية  تغييراً في  يعني  العدسة  تغيير  أن  جيداً  ويعرف 
مساحة  تلتقط  الزاوية  متسعة  العدسة  وأن  المنظر، 
أوسع من المنظر عما تلتقطه الزاوية الطويلة )ضيقة 
الزاوية(. ومعنى ذلك ببساطة أننا إذا وضعنا شيئاً يراد 
تصويره على مسافة محددة من الكاميرا، فإن العدسات 
التي تختلف في مقاساتها سوف تقدم لنا صوراً تختلف 
وحسب  عدسة  لكل  البؤري  البعد  )حسب  أحجامها  في 

زاويتها ( .

4 - أهم العدسات العادية الشائعة الاستخدام :

1 - العدسة ذات البعد البؤري الثابت :

2 - نظام العدسات المتعددة :

3 - البعد البؤري وزاوية العدسة :
الذي  هو  الكاميرا  في  العدسات  ونظام  طبيعة  إن 
استخدامها..  وأسلوب  كيفية  كبيرة  بدرجة  يحدد 

ويمكن توضيح ذلك على النحو التالي:

نظام العدسات وأداء الكاميرا:
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أنواع العدسات

بأنها  الطويل  البؤري  البعد  ذات  العدسات  تعرف 
ضيقة  رؤية  ذات  عدسة  المقربة«،وهي  »العدسة 
الأمامي  المستوى  بين  المسافة  وتضغط  نسبياً، 
المستوى  إلى  البعيدة  الأشياء  فتنتقل  والخلفي، 
استخداماً  تستخدم  فإنها  ثم  ومن  للصورة،  الأمامي 
الضيقة  الأماكن  التصوير في  إلى  الحاجة  فعالًا عند 
) مثل الغرفة اوالسيارة وغيرها..(، إلا أنها قد تسبب 
بعض المشكلات عند تصوير الأشخاص في لقطات 
قريبة، لأنها قد تسبب بعض المشكلات عند تصوير 
إبراز  في  تبالغ  لأنها  قريبة،  لقطات  في  الأشخاص 
اواليد  اوالأذن  )كالأنف  الملامح  وتضخيم  الأحجام 
وإلى  لذاته،  مقصوداً  ذلك  كان  إذا  غلا  وغيرها(، 
عمل  تعترض  أخرى  صعوبة  هناك  فإن  ذلك  جانب 
ينتج  إذ  35مم(  العدسة  )وخاصةً  العدسات  هذه 
بتشوه  يعرف  ما  الحالات  بعض  في  استخدامها  عند 
والأفقية  الرأسية  الخطوط  تظهر  حيث  البرميل، 
الخارج،  نحو  مقوسة  الشاشة  أطراف  من  القريبة 
أفقياً  الكاميرا  تحريك  عند  الصورة  شكل  ويتغير 

فتظهر الأشياء »منبعجة« الشكل.

إن تكامل الزاويتين يعني أن يكون مجموع الزاويتين 
180درجة، وعلى أساس التكامل بين وظيفة وخواص 
عدستين، صممت العدسة المقربة، فالمعروف أنك لو 
بإمكانك  يصبح  أخرى،  عدسة  أمام  عدسة  وضعت 
الرؤية  البؤري وبالتالي زاوية ومجال  أن تغير بعدها 
سالبة  عدسة  بإضافة  المقربة  العدسة  وصممت  لها 
خلف عدسة عادية قصيرة البعد البؤري، وبذلك فإنها 
والتضخيم  التكبير  أي  التليسكوب  يحققه  ما  تحقق 

الشديد لمساحة صغيرة من المنظر.

البعد  )متغيرة  البؤري  البعد  متعددة  عدسة  وهي 
البؤري )في حدود  البؤري( حيث يمكن تغيير بعدها 
معينة( أثناء تشغيل الكاميرا... ومن ثم تتغير زاوية 
الرؤية وبالتالي يتغير حجم الصورة... ويتم ذلك في 
بعيدة  أخرى  إلى  لقطة  من  )ونعومة(  وسهولة  يسر 
عليها  نحصل  التي  النتيجة  فإن  وبذلك  العكس..  أو 
باستخدام هذه العدسة، تشبه إلى حد كبير النتيجة 
التي نحصل عليها بتحريك الكاميرا والاقتراب بها من 

المنظور أو الابتعاد عنه، ومع ذلك فإن استخدام 
فاعلية  أكثر  ويكون  مناسباً  يكون  الزوم  العدسة 
الحركة المطلوبة سريعة )مثل  وتأثيراً عندما تكون 
بتحريك  نؤديها  أن  الانقضاض( وهي حركة يصعب 

الكاميرا والتقدم بها.

ولا شك أن عدسة الزوم تعد ذات أهمية كبيرة، فإلى 
جانب التأثير الخاص والفريد الذي تحققه في الحركة 
السريعة إلى الأمام أو الخلف )الانقضاض والتراجع(، 
وإلى جانب أنها تعد البديل المنفذ في الحالات التي 
يتعذر فيها تحريك الكاميرا )كما هو الحال عندما لا 
اهتزاز  إلى  الكاميرا غير ممهدة وتؤدي  تتوفر عليها 

أو  وارتعاشها..  الكاميرا 
بحيث  المكان ضيقاً  يكون 
الكاميرا  تحريك  يتعذر 
المطلوب  النحو  على 

والمرغوب(.. 
فإن  كله  ذلك  جانب  إلى 
بعدد  تزودنا  العدسة  هذه 
البرية  لانهائي من الأبعاد 
)في حدود مجال التقاطها(، 

ومن ثم فإنها تقوم مقام طاقم كامل من العدسات 
ذات الأبعاد البؤرية المختلفة.. ومع ذلك فإن عدسة 
الزوم وإن كانت متعددة الأغراض والمميزات، إلا انها 

لا تخلو كذلك من بعض الملاحظات والعيوب.

للصورة،  وضوح  أقصى  بأنه  البؤري  التركيز  يعرف 
ولتحقيق ذلك يجب أن تضبط العدسة على المسافة 
تصويره،  المراد  الغرض  أو  الموضوع  من  الصحيحة 
أو  الكاميرا  نحو  تحرك  إذا  »الغرض«  هذا  فإن  ولذا 
التركيز  بعيداً عنها يصبح )أي تصبح صورته( خارج 
البؤري.. يطلق عليه اصطلاح عمق الميدان أو عمق 
عمق  بأن  القول  يمكن  آخر  وبتعبير  الرؤية،  مجال 
أو  المنطقة  بأنه  الرؤية  المجال  عمق  أو  الميدان 
درجة  أقصى  في  الأشياء  فيها  تظهر  التي  المساحة 

من الوضوح دون تعديل في عدسة الكاميرا.

 وهي عدسات يمكن زيادة أو إنقاص الزوم ) من 
خلال حلقة الزوم الموجوده في العدسة ( 

رقمين هما  لها  يكون  النوع  وكل عدسة من هذا 
عبارة عن بداية ونهاية البعد البؤري للعدسة 

على سبيل المثال عدسة الكانون هذه  
40mm f/4L USM-Canon 17

بمعنى أن البعد البؤري لهذه العدسة يبدأ من 17 
40mm وينتهي عند  mm

إتساع  زاد  الرقم  نقص  كلما   : للمسألة  وتبسيطاً 
الزاوية و كلما كبر الرقم ضاقت الزاوية وزاد الزوم 

ثابت  بؤري  بعد  )ذات  الزوم  ثابتة  عدسات  وهي 
بمعنى لا يمكن تقريب الهدف عن طريق العدسة( 

على سبيل المثال عدسة النيكون هذه 
Nikon 50mm f/1.8 AF Nikkor mm
بمعنى أن البعد البؤري ثابت عند 50.

5 - العدسة طويلة البعد البؤري )ضيقة الزاوية( :

8 - العدسة طويلة البعد البؤري )ضيقة الزاوية( :

6 - العدسات المتكاملة )المقربة( :

7 - العدسة الزوم :

: Zoom lens -1

: prime lens -2



23 www.creativesminds.wordpress.comMay  - 2012  العودة إلى فهرس المجلة

أنواع العدسات

تزود العدسات عادةً بالديا فراجم القزحي الذي يمكن 
إغلاقه وفتحه.. وهو يشبه في وظيفته حدق العين 
»iris« حيث يمكن التحكم في إغلاقه وفتحة للتحكم 
ويمكن  الداخل..  إلى  تنفذ  التي  الضوء  كمية  في 

تحديد وظيفة الديافراجم في مهمتين هما:
الإضاءة  لمنظر-أو  )لمعانا  الضوء  كمية  ضبط   

المنعكسة عن الصورة( التي تدخل وتسقط على 
1 - صمام الكاميرا أو الفيلم.

2 - أنه يغير عمق الميدان )عمق مجال الرؤية(.
صمام  إلى  تنفذ  التي  الضوء  كمية  أن  والمعروف 
الكاميرا وتؤثر تأثيراً مباشراً في شكل ودرجة وضوح 
الصورة على شاشة جهاز التلفزيون.. فعندما تكون 
بالتعريض  يعرف  ما  وهو  الكبيرة-  الضوء  كمية 
الزائد- ينتج عن ذلك صورة باهتة لا تبرز التفاصيل، 
مما  )أقل  كافية  غير  الضوء  كمية  تكون  عندما  أما 
يجب( فإن ذلك يؤدي إلى عدم وضوح الصورة حيث 
تسيطر عليها درجة من القتامة أو )السواد(، وتختفي 
الظلي فيها، ويطلق  والتدرج  اللوني  التباين  درجات 
اصطلاح  الكافية  غير  أو  القليلة  الضوء  كمية  على 

»التعريض الناقص«.
القزحية  الفتحة  هذه  وبواسطة  فإنه  ذلك  وعلى   
كمية  في  التحكم  يتم  بالديافراجم-  تعرف  التي 
الضوء )التيهي درجة لمعان المنظر( التي تنفذ إلى 

داخل الصمام أو الفيلم حيث يمكن فتح الديافراجم 
 ''F''بأرقام تسمى الأرقام البؤرية ويرمز إليها بحرف
صغر  كلما  البؤري،  الرقم  كبر  كلما  أنه  والمعروف 

قطر فتحة الديافراجم )أي فتحة العدسة(.
بعلامات  هذا  العدسة  فتحة  مقاس  تدريج  ويتم 
يعني  واحدة  علامة  العدسة  وفتح  بؤرية..  أرقام  أو 
السماح بدخول ضعف الضوء، وفتحها علامتين يعني 
مرور أربعة أمثال الضوء، وثلاث علامات يسمح بمرور 
فإن  تماماً  ذلك  من  العكس  وعلى  أضعاف..  ثمانية 
غلق العدسة علامة واحدة يقلل الضوء إلى النصف، 

وعندما نغلقها علامتين فإنه لا يمر إلا الربع.
وبين عمق  الضوء  كمية  بين  أساسية  وهنا كعلاقة 
مجال الرؤية )المعروف أنه كلما زادت فتحة العدسة 
للمصور  يتوفر  وبذا  الوضوح(  مجال  عمق  قل  كلما 
كلما  المجال  عمق  تحديد  في  المرونة  من  المزيد 
توفرت له إضاءة قوية. أما إذا كانت الإضاءة أقل من 
المطلوب فإن ذلك إلى ضحالة مجال الرؤية. ومع ذلك 
فإن الضوء الزائد عن القدر المطلوب قد يبدد المكان 
التوازن  أن  ببساطة  القول  يمكن  هنا  ومن  تماماً.. 
هو  الصورة  أنحاء  في  والظلام  الضوء  بين  السليم 
التي  الدقيقة  الديافراجم  فتحة  وأن  الإيهام،  مصدر 
الصمام  لحساسية  تبعاً  تختلف  صورة  أجود  تعطي 
وكمية الضوء الساقط على المنظر ودرجة انعكاسه.

9 - فتحة العدسة :

المرجع
كتاب الاعلام الجديد والصحافه الالكتروني

الاستاذ الدكتور عبدالرزاق محمد الدليمي
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سلسة دروس  برنامج
: CorelDraw 

الدرس الأول :

بقلم : محمد زرقة
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واجهة البرنامج الرئيسية :

:  New Blank Document - 1

:  Open Recent - 3

:  Open Other - 4

: Preveiw - 5

: Information - 6 :  New From Template - 2

فور تشغيل البرنامج ستظهر نافذة / Quick Start /  والتي 
تحوي أوامر استدعاء الملفات المنفذة مسبقا و أوامر إنشاء 

الملفات . و هي : 

بإعدادات  فارغ  جديد  كورل  ملف  إنشاء  مختص   الأمر  هذا 
البرنامج الافتراضية و الأساسية .

و يعرض هنا آخر عشرة ملفات تم فتحها على برنامج الكورل

اختيار  من  ليمكنك  الملفات  مستعرض  نافذة  بفتح  يقوم  و 
الملف الذي تريده .

في هذا الجزء يقوم بعرض الملف المطلوب بصورة مصغرة

في هذا الجزء يقوم بعرض معلومات عن الملف إن وجدت البرنامج  بإعدادات  فارغ  جديد  كورل  ملف  إنشاء  هي  و 
الافتراضية و الأساسية .
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طريقة تعامل البرنامج مع العناصر   :
بكل  و   )  Layers  ( الطبقات  مبدأ  يستخدم  البرنامج  ان 
يكفي  فيه  العمل  لتبسيط  لكن  و  العناصر  الاف  يضع  طبقة 
المستخدم ان ينقر على العنصر المراد العمل فيه باستخدام 
أداة Pick Tool  فيظهر حول العنصر ثماني مربعات سوداء 
توضح لك ان العنصر المحدد بهذه النقاط هو العنصر الذي 

سيجري عليه التعديلات التي تريد كما في الصورة التالية :

تلوين العناصر :
إن لكل عنصر في هذا البرنامج و اي برنامج اخر يعمل بنظام 
  )... Adobe Illustrator - Free Hand ( الرسم الشعاعي
لونان أو مستويين لونين الأول لون ملئ العنصر  ) Fill ( و 

. ) Outline ( الثاني لون إطار العنصر
و للتحكم بلون ملئ العنصر نختار اللون المطلوب بالنقر عليه 

بزر الماوس اليسار , أما النقر بزر الماوس الأيمن فيتحكم بلوز 
إطار العنصر . 

قد نرغب بجعل لون اطار العنصر أو حتى ملؤه شفاف ففي هذه 
. / none / الحالة نستخدم اللون

شريط الخصائص :
إن شريط الخصائص عنصر مهم جدا في هذا البرنامج فهو 
بتغير  فيقوم  عليها  بالعمل  تقوم  أداة  اي  خصائص  يحتوي 
أو  المستخدمة  الأداة  أو يحرف من شكلها حسب  خصائصها 

حسب العنصر المرسوم و المحدد .

كما يحتوي في قسمه الأول جميع اعدات المقاس و الموقع و 
زاوية دوران العنصر و ما إلى ذلك و سنقوم بشرحها انشالله 

الخصائص  شريط  سيتغير  ما  عنصر  مختارين  كنا  حال  وفي 
عنصر  مختارين  كنا  فلو   ، المختار  العنصر  خصائص  ليعطينا 

المربع مثلا سيصبح الشريط كما في الشكل التالي :

و سنقوم بشرح هذا الشريط بقسميه لأنه يقسم إلىقسمين  
القسم الأول و قسم مشترك لجميع العناصر التي يتم ادراجها 
موقع  و  بالمقاس  المخصص  القسم  هو  و  البرنامج  بهذا 
العنصر المرسوم بالنسبة للصفحة و زاوية دورانه و مرآته ... 

و هو الجزء الأيسر من الشريط :

و القسم الثاني و هو الأيمن و هو يتغير حسب العنصر المختار 
حيث انه يعطي خصائص العنصر المرسوم كما أسلفنا سابقا
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رسم أول عنصر :
رسم  أداة  سنستخدم  مثلا  مربع  ليكن  و  ما  عنصر  لنرسم 
الأشكال الجاهزة و نختار المستطيل  و نضغط بزر الماوس ثم 

نسحب حتى يرسم الشكل
 

و سنشرح الآن شريط الخصائص بعد رسم المربع حيث سيقسم الى قسمين كما ذكرنا 

Object Position - 1 : و هنا يقوم البرنامج بعرض موقع مركز العنصر المختار ) إحداثياته (  بالنسبة لمركز الصفحة  ) و 
يكون بالزاوية اليسرى السفلية للصفحة ( 

Object Size - 2 : و هنا يقوم البرنامج بعرض مقاس العنصر طول و عرض حسب وحدة القياس المختارة

الحجم  عن  العنصر  عدلت حجم  ان  أي  المئوية  بالنسبة  العنصر  بعرض حجم  البرنامج  يقوم  هنا  و   :  Scale Factor  -  3
الأساسي الذي قمت برسمه فسيعطيك نسبة التكبير او تصغير كنسبة و ان اردت إرجاعه لحجمه الاساسي عند انشائه يكفي 

بأن تعيد الرقم لـ 100 % 

Lock Ratio - 4  : و هذا القفل يقوم برط الطول بالعرض في حقل Scale Factor أي أن أي تعديل لنسبة الطول سيتأثر 
طردا مع نسبة العرض أما إن ألغينا هذا القفل فبإمكانك تغير النسبة للطول على حدا و العرض على حدا دون التأثير على الآخر

Angel Of Rotation - 5 : زاوية دوران العنصر ، عند إنشاء العنصر تكون زاوية دورانه 0 درجة فإن أردت أن تديره نحو 
اليسار فتكون زاوية الدوران موجبة اما ان أردت ان تدير العنصر باتجاه اليمين فتكون القيمة سالبة كما في المثال التالي:

Mirror Horizantally - 6 :  ويقوم هذا الأمر بقلب العنصر افقيا أي اعطاء مقلوب العنصر بشكل افقي

Mirror Vertically - 7 : ويقوم هذا الأمر بقلب العنصر عاموديا أي اعطاء مقلوب العنصر بشكل عامودي
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: ) Zoom Tool ( أوامر الإبحار و التحكم بحجم عرض العناصر
العناصر ضمن الملف  المقصود هنا التحكم بتقريب و تبعيد 
لتستطيع التركيز على عنصر محدد او عدة عناصر عن قرب او 
اظهار عنصر محدد فقط أو إظهار كل العناصر بالملف و هناك 
( بامكانك   Mouse Scroll ( عدة طرق للتحكم بها و منها 
او  اليه  التقريب  المراد  العنصر  فوق  الماوس  مؤشر  وضع 
بالماوس لتشاهد  الخاص  الابتعاد عنه  و استخدم السكرول 

النتيجة .
أو استخدم أداة المكبرة 
قائمة  مع  الموجودة 
البرنامج   في  الأدوات 
عدة  الأداة  لهذه  و 
من  تمكنك  خصائص 

استدامها بشكل جيد , فعند طلب هذه الأداة سيظهر بشريط 
الخصائص العلوي خصائص هذه الأداة كالتالي :

الأجزاء  عرض  و  الملف  لازاحة    )  Pan  ( اليد  أداة  استخدام 
و  البرنامج  بواجهة  الخاصة  العرض  مساحة  في  المختبئة 
و  الزوم  أداة  على  مطولا  بالضغط  الأداة  هذه  طلب  يمكنك 
اختيار الخيار التالي و هو Pan  او عن طريق استخدام الاختصار 

.  ) H ( الخاص بالأداةو هو
الفأرة و ذلك عن طريق الضغط على زر  أو يمكنك استخدام 

السكرول و قم بالتحريك يمينا أو يسارا .

و إلى اللقاء في الدرس القادم ان شاء الله 

) F2 ( 1 - و تستخدم للتقريب, اختصارها

 ) F3 ( 2 - و تستخدم للتبعيد, اختصارها

كامل  على  عرضه  و  المحدد  العنصر  لجلب  تستخدم  و   -  3
الشاشة و هذه الأداة تكون غير فعالة في حال لم تكن محدد 
اي عنصر ، يجب ان تكون مختار عنصر واحدا على الأقل حتى 

) Shift + F2 ( تتفعل هذه الأداة. اختصارها

4 - و تستخدم لجلب كل العناصر في الملف و عرضهم بشكل 
 ) F4 ( كامل على النافذة . اختصارها

5 - و تستخدم لعرض الصفحة كاملة في الملف ,  اختصارها 
)  Shift + F4 (

الشاشة مع تجاهل  6 - تقوم بتقريب عرض الصفحة ليلائم 
طولها

تجاهل  مع  الشاشة  ليلائم  الصفة  طول  بتقريب  تقوم   -  7
عرضها .
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إنشاء مشهد التحميل
Swish Max 4 باستخدام

مقدمة الفلاش لموقعك الإلكتروني تعطي الموقع صورة حيوية و فعالة  تكون ملفته لأنظار الزوار والمشاهدين و 
تترك لديهم  إنطباع مميز .

ميزه  ذو  أولي  إنطباع  الناظر  لتعطي  صوتية  مؤثرات  مع  قصير  حركي  فلاش  تستخدم  المميزه  الفلاش  مقدمة 
خاصة. مقدمة الفلاش المتحركة  هي طريقة ممتعة لتضيف الحركة على الموقع الإلكتروني. و هو يحفز و يحسن 

التأثير المطلوب على الزائر لإعطائه تجربة رائعة. 
 swish لمقدمة الفلاش باستخدام برنامج )Loading( وسنتحدث في هذا المقال عن طريقة عمل مشهد التحميل

.max 4

المشهد   ، مشهدين  يلزمنا  التحميل  مشهد  لعمل 
الأول للقطة التحميل ، والمشهد الثاني للعرض. 

نقوم بتعديل أسماء المشاهد للتمييز بينهم لسهولة 
العمل وخاصة عند وجود العديد من المشاهد

 preloading .. سنقوم  بتسمية مشهد التحميل
main .. ومشهد العرض 

والآن .. في مشهد التحميل نضيف النص والمؤثر الذي سيظهر في مشهد التحميل .

ثم نذهب إلى قسم script  ونكتب الأوامر كما في الصورة:

بقلم : نسمة قطان
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إنشاء مشهد التحميل 
Swish Max 4 باستخدام

ملاحظة :
 يجب التأكد من ان التأثير لا يزيد أو ينقص عن أوامر التحميل في مدته الزمنية.

وهكذا نكون قد انتهينا من عمل مشهد التحميل . 
ونتابع تصميم المشهد الثاني )مشهد العرض( .. ليكون مشهد التحميل مكتملا ..

أتمنى أن أكون قد وفقت تقديم الفكرة .. ونلتقي في موضوع جديد بإذن الله …
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الاختصارات الكاملة
CS5 لبرنامج الفوتوشوب

S Command Short. الاختصار الأمر م
1 MOVE V ر حرك 1
2 Marque tools M ة أدوات التحديد 2
3 Lasso tools L م أداة التحديد الحر 3
4 Quick selection, Magic Wand W ض أدوات التحديد السريع 4
5 Crop and Slice tools C ؤ أدوات القص 5
6 Eyedropper, Color Sampler, Ruler, Note, Count I ه أداة القطارة ) استنساخ اللون ( 6
7 Spot Healing Brush, Healing Brush, Patch, Red Eye J ت 7 أدوات المعالجة
8 Brush, Pencil, Color Replacement, Mixer Brush B لا الفرشاة 8
9 Clone Stamp, Pattern Stamp S س أداة الاستنساخ 9
10 History Brush, Art History Brush Y غ تاريخ الفرشاة 10
11 Eraser tools E ث الممحاة 11
12 Gradient, Paint Bucket G ل التلوين التدريجي 12
13 Dodge, Burn, Sponge O خ 13 التفتيح و التعتيم
14 Pen tools P ح أدوات القلم 14
15 Type tools T ف أداة الكتابة 15
16 Path Selection, Direct Selection A ش اختيار المسار 16

17 Rectangle, Rounded Rectangle, Ellipse, Polygon, 
Line, Custom Shape U ع 17 رسم الاشكال الجاهزة

18 3D tools K ن )أدوات الرسم الفراغي )ثلاثي الأبعاد 18
19 3D Camera tools N ى كاميرا التصوير ثلاثي الأبعاد 19
20 Hand H ا اليد 20
21 Rotate R ق التدوير 21
22 Zoom Z ئ التكبير 22
23 Default colors D ي الألوان الأساسية 23
24 Switch Foreground and Background colors X ء التبديل بين اللون الأمامي واللون الخلفي 24
25 Quick Mask Mode Q ض الماسك السريع 25
To switch between all tools within groups, add the Shift key 
to the letters above.
For example, to switch between rectangular and elliptical 
marquee............Shift-M

للتبديل بين الأدوات من نفس النوع ) كتبديل انواع التحديد مربع 
- دائرة ... ( يتم الضغط على زر Shift مع اختصار الأداة

كثيرة هي الأوامر و الأدوات في هذا البرنامج الضخم ، ولكن شركة أدوبي العالمية اختصرت الوقت و المسافات على المستخدم 
حيث انها ادرجت لأغلب الأوامر اختصارات و خصوصا الأكثر استخداما منها ، و كثيرون جدا من يسألونني ... هل يوجد كتيب 
خاص بهذه الاختصارات ؟؟؟ هل يوجد دليل يمكنني استخدامه لكي استذكر هذه الأوامر لأنني مستجد و قد اختلطت معي 
الكثير  ... و لكن  البرنامج خارطة كاملة للأوامر مع اختصاراتها  انه يوجد داخل  ... و يكون جوابي هو  الأوامر و اختصاراتها 
يستصعب التعامل معها ... لذلك ... و بمساعدة كريمة من الانسة ) لمى بركات ( قامت مشكورة بجمع هذه الأوامر و ترجمتها 

للغة العربية و كانت نتاج عملها كالتالي :

1 - الاختصارات الخاصة بصندوق الأدوات :

بقلم : لمى بركات
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2 - الاختصارات الخاصة بأوامر التحديد :

3 - الاختصارات الخاصة بأوامر الملاحة )التكبير و التصغير ( :

S Command Short. الاختصار الأمر م

1 Draw Marquee from Center Alt-Marquee ضغط Alt بالتزامن مع 
رسم التحديد رسم التحديد من المركز 1

2 Add to a Selectionف Shift ضغط Shift أثناء 
التحديد الإضافة إلى التحديد 2

3 Subtract from a Selection Alt ضغط Alt بعد إنشاء 
التحديد الاقتطاع من التحديد 3

4 Intersection with a Selection Shift-Alt
ضغط Shift  و Alt بعد 
رسم التحديدات التي 
يراد اقتطاع تشاركاتها

أخذ اقتطاع التحديدات 4

5 Make Copy of Selection w/Move 
tool Alt-Drag Selection Alt بالتزامن مع سحب 

التحديد نسخ التحديد 5

6 Make Copy of Selection when not 
in Move tool

Ctrl-Alt-Drag 
Selection

Ctrl + Alt وسحب 
التحديد

نسخ التحديد دون أن نكون 
في حالة أداة التحريك 6

7 Move Selection (in 1-pixel 
Increments) Arrow Keys باستخدام الأسهم تحريك التحديد بقطر 1 

بيكسل 7

8 Move Selection (in 10-pixel 
Increments) Shift-Arrow Keys Shift والأسهم تحريك التحديد بقطر 10 

بيكسل 8

9 Select all Opaque Pixels on Layer
Ctrl-click on Layer 

Thumbnail (in 
Layers panel)

ضغط Ctrl مع الضغط 
على رمز الشفيفة في 

لوحة التحكم بالشفيفات

اختيار كل البيكسلات الدائرية 
في الشفيفة 9

10 Restore Last Selection Ctrl-Shift-D Ctrl + Shift + ي استعادة آخر تحديد 10
11 Feather Selection Shift-F6 Shift + F6 تحديد منسق 11

12 Move Marquee while drawing 
selection

Hold Space while 
drawing marquee

اضغط على زر المسافة 
أثناء رسم التحديد تحريك التحديد أثناء رسمه 12

S Command Short. الاختصار الأمر م

1 Fit on Screen Double-click on 
Hand tool or Ctrl-0

ضغطتين على إشارة 
Ctrl + 0 اليد أو ملائمة للشاشة 1

2 100% View Level (Actual Pixels)
Double-Click on 

Zoom Tool or Ctrl-
Alt-0

ضغطتين على أداة 
 Ctrl + Alt التكبير أو

+ 0
عرض 100 % 2

3 Zoom in Ctrl-Space-Click 
or Ctrl-Plus(+)

Ctrl + Space  أثناء 
)+( + Ctrl الضغط أو التكبير 3

4 Zoom out Alt-Space-Click or 
Ctrl-Minus(–)

Alt + Space  أثناء 
)-( + Ctrl الضغط أو التصغير 4

5 Hide all tools and panels Tab Tab اخفاء أشرطة الأدوات 5

6 Hide all panels except Toolbox 
and Options bar Shift-Tab Shift + Tab

اخفاء أشرطة الأدوات ماعدا 
صندوق الأدوات وشريط 

الخيارات
6

7 Rotate through full screen modes F ب التدوير داخل إطار العرض في 
كامل الشاشة 7

8 Scroll image left or right in 
window

Ctrl-Shift-Page 
Up/Down

 Ctrl + Shift + Page
up / Down

تحريك الصورة يسارا أو يميناً 
في الشاشة 8

9 Jump/Zoom to part of Image Ctrl-drag in 
Navigator panel

Ctrl وسحب في شريط 
الأدوات

التحرك إلى جزء معين من 
الصورة مع التكبير 9

10 Toggles layer mask on/off as 
rubylith \ ظ قفل الشفيفة 10
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S Command Short. الاختصار الأمر م

1 Create new layer Ctrl-Shift-N Ctrl + Shift + N إنشاء شفيفة جديدة 1

2 Select non-contiguous layers Ctrl-Click layers Ctrl بالتزامن مع 
الضغط على الشفيفة

تحديد الشفيفات غير 
المتجاورة 2

3 Select contiguous layers
Click one layer, 
then Shift-Click 
another layer

ضغط شفيفة واحدة، ثم 
Shift مع الضغط على 

الشفيفة التالية
تحديد الشفيفات المتجاورة 3

4 Delete Layer Delete key (while 
in the Move tool)

Delete )عندما تكون 
في وضعية التحريك( حذف الشفيفة 4

5 View contents of layer mask Alt-Click layer 
mask icon

Alt + الضغط على 
أيقونة القناع مشاهدة الماسك )القناع( 5

6 Temporarily turn off layer mask Shift-Click layer 
mask icon

Shift بالتزامن مع 
الضغط على أيقونة 

الماسك
الخروج من الماسك 6

7 Clone layer as you move it Alt-Drag Alt مع الضغط على 
الشفيفة وسحبها نسخ شفيفة 7

8 Find/Select layer containing 
object

Right-Click on the 
object w/Move tool

الضغط بالزر اليميني 
على العنصر واختيار رقم 

الشفيفة
اختيار شفيفة تحتوي عنصر ما 8

9 Change layer opacity
Number pad keys 

(w/Move tool 
selected)

استخدام الارقام مع 
 W حرف

تغيير درجة الألوان في 
الشفافية 9

10 Cycle down or up through blend 
modes

Shift-Plus(+) or 
Minus(–) Shift مع + أو مع - blend التبديل بين اشكال ال 10

11 Switch to layer below/above 
current layer Alt-[ or Alt-] Alt مع ]  أو Alt مع [ التبديل إلى الشفافية الأعلى أو 

الأدنى 11

12 Move layer below/above 
current layer Ctrl-[ or Ctrl-] Ctrl مع ] أو Ctrl مع [ تحريك الشفافية إلى أسفل 

الشفافية الحالية أو فوقها 12

S Command Short. الاختصار الأمر م

1 Select all text on layer
Double-Click on 
T thumbnail in 
Layers panel

ضغطة مضاعفة على 
الزر الأيمن للفأرة على 

رمز النص في يسار 
الشاشة

تحديد كل النص الموجود في 
الشفافية 1

2 Increase/Decrease size of 
selected text by 2 pts Ctrl-Shift->/< </>-Ctrl-Shift تكبير الخط أو تصغيره بمعدل 

2 نقطة 2

3 Increase/Decrease size of 
selected text by 10 pts Ctrl-Shift-Alt->/< </>-Ctrl-Shift-Alt تكبير الخط أو تصغيره بمعدل 

10 نقطة 3

4 Increase/Decrease kerning/
tracking

Alt-Right/Left 
Arrow

Alt مع السهم اليسار أو 
اليمين

زيادة المسافة بين الحروف أو 
انقاصها 4

5 Align text left/center/right. Ctrl-Shift-L/C/R Ctrl-Shift-L/C/R محاذاة النص 5

: ) Layers - 4 - الاختصارات الخاصة بقائمة الطبقات ) الشفائف

5 - الاختصارات الخاصة بأوامر أداة الكتابة ) النصوص ( :
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S Command Short. الاختصار الأمر م

1 To get Direct Selection tool while 
using Pen Ctrl Ctrl للحصول على أداة التحديد 

المباشر أثناء استخدام القلم 1

2 Switch between Add-Anchor and 
Delete-Anchor Point tools Alt Alt التبديل بين أداتي إضافة 

انحناء أو إزالة انحناء 2

3
Switch from Path Selection tool to 
Convert Point tool when pointer is 
over anchor point

Ctrl-Alt Ctrl-Alt

التبديل بين أداة التحديد 
المباشر وأداة تحويل النقطة 

عندما يكون المؤشر فوق 
النقطة

3

4 To Select a whole path w/Direct 
Selection tool Alt-click Alt-click لتحديد مسار كامل W / أداة 

التحديد المباشر 4

5 Convert path to a selection
Ctrl-click on path 
name (in Paths 

panel)

الضغط على اسم 
المسار )في لوحة 
Ctrl المسارات( مع

تحويل المسار إلى تحديد 5

S Command Short. الاختصار الأمر م

1 Fill selection with background 
color Ctrl-Backspace Ctrl-Backspace تعبئة التحديد باللون الخلفي 1

2 Fill selection with foreground 
color Alt-Backspace Alt-Backspace تعبئة التحديد باللون الامامي 2

3
Fill selection with foreground 
color using Lock Transparent 
Pixels

Shift-Alt-
Backspace

Shift-Alt-
Backspace

تعبئة التحديد باللون الامامي 
مع قفل باقي الشفافية 3

4 Fill selection with source state 
in History panel Ctrl-Alt-Backspace Ctrl-Alt-Backspace تعبئة التحديد باللون موجود 

في لوحة التاريخ 4

5 Display Fill dialog box Shift-Backspace Shift-Backspace عرض صندوق التعبئة 5

6 Sample as background color Alt-Click w/
Eyedropper tool

Alt-Click w/
Eyedropper tool عينة من اللون الخلفي 6

7 To get Move tool
While in any 

painting/editing 
tool-hold Ctrl

اضغط Ctrl مع أي ادارة 
رسم أو تعديل للحصول على أداة التحريك 7

8 To get Eyedropper with Paint 
tools Alt Alt للحصول على اداة التنقيط 

اللوني مع أداة الرسم 8

9 Change paint opacity (with 
Airbrush OFF) Number keys أزرار الارقام تغيير درجة اللون )عندما تكون 

الAirbrush غير مفعلة( 9

10 Change paint opacity (with 
Airbrush ON) Shift-Number keys Shift أزرار الارقام مع تغيير درجة اللون )عندما تكون 

الAirbrush مفعلة( 10

11 Change Airbrush flow (with 
Airbrush ON) Number keys أزرار الارقام

 Airbrush تغيير انسيابية ال
 Airbrushعندما تكون ال(

مفعلة(
11

12 Change Airbrush flow (with 
Airbrush OFF) Shift-Number keys Shift أزرار الارقام مع

 Airbrush تغيير انسيابية ال
)عندما تكون الAirbrush غير 

مفعلة(
12

13 Cross-Hair Cursor
Any painting/editing 
tool-turn Caps Lock 

on

أي أداة رسم أو تعديل مع 
caps lock تشغيل ال تحويل إلى المؤشر الصغير )+( 13

14 Decrease/Increase Brush Size [ or ] ] أو [ تكبير أو تصغير الريشة 14

15 Decrease/Increase Hardness of 
Brush Shift-[ or Shift-] ]-Shift أو [-Shift تزويد أو تخفيض قساوة الفرشاة 15

16 Switch between preset Brushes < or > > أو < التبديل بين اشكال الفرش 
الافتراضية 16

17 Open Brushes pop-up panel Right-Click in 
Image window

ضغطة على الزر اليمين 
في نافذة الصورة فتح لوحة اشكال الفرشاة 17

: )  Pen Tool - 6 - الاختصارات الخاصة بأوامر أداة رسم المسارات ) القلم

7 - الاختصارات الخاصة بأوامر الرسم و التلوين :
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S Command Short. الاختصار الأمر م

1 Switch between open documents Ctrl-Tab Ctrl-Tab التنقل بين الملفات المفتوحة 1

2 Undo or Redo operations beyond 
last one

Ctrl-Alt-Z/Ctrl-
Shift-Z

Ctrl-Alt-Z/Ctrl-
Shift-Z

إعادة الخطوة السابقة أو 
التراجع عنها 2

3 Apply Last Filter Ctrl-F Ctrl-F تطبيق آخر فلتر 3

4 Opens Last Filter Dialog Box Ctrl-Alt-F Ctrl-Alt-F فتح صندوق أخر الفلاتر 
المستخدمة 4

5 Hand Tool Spacebar المسافة أداة اليد 5

6 Increase/Decrease value (in any 
option field) by 1 unit Up/Down Arrow السهم العلوي أو 

السفلي
تزويد أو تخفيض القيمة في 

أي حقل بقيمة 1 6

7 Increase/Decrease value (in any 
option field) by 10 units

Shift-Up/Down 
Arrow

السهم العلوي أو 
Shift السفلي مع

تزويد أو تخفيض القيمة في 
أي حقل بقيمة 10 7

8 Replay last Transformation Ctrl-Shift-T Ctrl-Shift-T إعادة تطبيق التعديل الأخير 8

9 Measure Angle between Lines 
(Protractor Function)

After ruler is 
drawn, Alt-Drag 
end of line with 

Ruler Tool

بعد سحب المسطرة 
الضغط على Alt مع 

سحب نهاية الخط مع 
أداة المسطرة

قياس الزاوية بين الخطوط 9

10 Move Crop Marquee while 
creating

Hold Space while 
drawing

الضغط على زر المسافة 
أثناء الرسم

تحريك علامة القص أثناء 
الانشاء 10

7 - بعض الاختصارات الأخرى :
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http://www.facebook.com/glow.by.saidomari
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للبشر  بالنسبة  الشمس،  عملية  أن  المعروف  من 
قوة  وحسب  كافية  إضاءة  وجود  حالة  في  إلا  تتم  لا 
لغير  بالنسبة  أما   ، الرؤية  العين تكون قوة  وسلامة 
البشر وخاصة بعض الحيوانات والطيور وغيرها فإن 
في  معينة  بنسبة  ولو  للإبصار  خاصة  قدرات  لديها 

حالة وجود إضاءة ضعيفة أوعدمها بتاتا.

وهي في الدرجة الأولى الشمس ، أما القمر والنجوم 
فإن إضاءتها غير كافية للرؤية الواضحة.

وهي التي يمكن رؤيتها بالعين المجردة حيث نتعامل 
معها ليل نهار، وتعرف بألوان الطيف، وتشمل جميع 
درجات الأشعة المرئية، ابتداء من الأشعة البنفسجية، 

وانتهاء بالأشعة تحت الحمراء.

أهمية  رغم   ، المجردة  بالعين  رؤيتها  لايمكن  وهي 
الواسعة  واستخداماتها   ، وفوائدها   ، منها  العديد 
طبية  استخدامات  ولها  الحمراء  تحت  الأشعة  ،ومنها 
السينية  الأشعة  ومنها   ، وعسكرية  أمنية  وأخرى 
أو عيادة  يمكن لأي عيادة عظام  والتي لا  المعروفة 

أسنان أن تخلو منها.
ومنها أيضا موجات الإذاعة والتلفاز والرادار.

مختلفة  أنواع  كانت  أيا  الضوء  مصادر  عن  تصدر 
نوعين  إلى  رئيسة  بصورة  وتنقسم   ، الأشعة  من 

أساسيين هما :

بدرجة  تتم  أن  ضوئية  تصوير  عملية  لأي  يمكن  لا 
عالية من الجودة دون توفر كمية ونوعية مناسبة من 
،ولذلك لابد من مراعاة  أو صناعي  ، طبيعي  الضوء 
مع   ، مقبولة  صور  على  نحصل  كي  النقطة  هذه 
توفر ظروف أخرى كنوعية الفيلم ودرجة حساسيته 

المناسبة لنوعية واستخدام أمثل لكاميرة نفسها. 

الفوتوغرافية  الصورة  تكوين  عملية  تعريف  يمكن 
تلك  داخل  للموضوعات  الملائم  التنظيم  أنها  على 

الصورة.

وتتعدد هذه المصادر ، ابتداء من عود الثقاب ، وانتهاء 
بأكبر كشاف كهربائي .

الضوء والإبصار :

الضوء هو البداية مصادر الإضاءة :

الضوء هو البداية مصادر الإضاءة :

العلاقة بين الضوء والتصوير الفوتوغرافي :

تكوين الصورة
الفوتوغرافية

1 - إضاءة طبيعية :

1 - الأشعة المرئية :

2 - الأشعة غير المرئية :

2 - إضاءة صناعية :

بقلم : غادة عوامات
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تكوين الصورة 
الفوتوغرافية

أولًا - البساطة :

ثانياً - الخط :

هناك عدد من قواعد أو عناصر التكوين التي تساعد في إنتاج صورة مقبولة إثناء قيامك بالتصوير منها :

تشكل البساطة السر الكامن وراء العديد من الصور الجيدة وهو اختيار 
موضوع للصورة يكون قابلا لإجراء عملية التبسيط ،فعلى سبيل المثال 
بدلا من محاولة تصوير منطقة أو مجال كامل قد يشوش على الناظر 

يمكن  التركيز على بعض الجوانب المهمة في المنطقة 
الأول  الانطباع  يكون  ما  نادرا  أنه  لها  الانتباه  يجب  التي  الأمور  ومن 
الموضوع  أولا حول  التجول  لذلك يجب  أفضل صورة  لأي موضوع هو 
ودراسته والنظر إليه من جميع الجهات، فينظر إلى ذلك الموضوع من 
عين  »منظور  منخفضة  زاوية  ومن  الطائر«  عين  عالية«منظور  زاوية 
الدودة« ومن جهة النظر العادية ثم دراسة علاقة الموضوع بما يحيط 
به بما في ذلك خلفية الصورة ومقدمتها، ثم دراسة الموضوع الرئيسي 
وبعد  واتجاهه  الموضوع  على  الساقط  والضوء  الفرعية  والموضوعات 
لكي  به  يحيط  عما  ونفصله  تصويره  المراد  الجزء  نعزل  ثم  الدراسة، 

نقدمه للمشاهد في أبسط صورة وأكثرها مباشرة.

في معظم عمليات التكوين الفوتوغرافي للخط أربعة أشكال أو تركيبات أساسية وهي :
1 -  الخطوط الرأسية .
2 -  الخطوط الأفقية .

3 -  الخط المائل. 
4 -  الخط المنحني .

ويشتمل التصوير الفوتوغرافي بصفة أساسية على خطوط رأسية متينة وصلبة ومتماسكة، ويظهر ذلك في 
الخطوط  توحي  ما  وغالبا  رأسية  إشكال خطية  من  تتألف  فهي  وماشابهها،  كالمساجد  الضخمة  المباني  صور 

الرأسية بالقوة.



40 www.creativesminds.wordpress.comMay  - 2012  العودة إلى فهرس المجلة

1 - الخطوط القائدة: 

2 - خطوط التنسيق أو التكوين : 

3 - خطوط القوة : 

أما الخطوط الأفقية الطويلة فتوحي بالهدوء والاستقرار أو السكون وتظهر في صور المباني الضخمة ذات الامتداد 
الأفقي الكبير.  

أهم  من  الصورة  في  الأفقي  الخط  ويعتبر 
الخطوط ،فيجب أن يقسم الصورة بحيث يكون 
الخط،  أعلى  والثلث  الخط  أسفل  الصورة  ثلثا 
أن  رأسي  خط  أي  أو  الأفق  خط  على  يجب  ولا 
في  التكوين  لان  قسمين  إلى  الصورة  يقسم 
هذه الحالة يثير الملل. أما الخط المائل فيتسم 
وذلك  الاستقرار  وعدم  والحركة  بالديناميكية 
كالجاذبية  الطبيعية  العوامل  ببعض  لارتباطه 
الأرضية حيث تمثل أساسا خطوط راسية توشك 
على الوقوع كالشجرة الراسية مثلا حين تصبح 
في خط مائل لحظة سقوطها،ويجب الانتباه إلى 
ملحوظة هامة على الخطوط المائلة وهي أنه لا 
ينبغي لهذا الخط أن يمتد من أحد أركان الصورة 

إلى الركن المقابل بحيث يقسم الصورة إلى نصفين متساويين
أما الخطوط المنحنية في الصورة فتعطي إحساسا بالحركة الهادئة حيث يقلل من سرعة حركة العين وتوحي بالتمهل 

وتؤدي إلى  إمعان النظر فتستغرق مدة أطول .

وهي خطوط في الصورة تقود العين إلى موضعها الرئيسي مثل قضبان سكك الحديد تقود العين إلى القطار 
أو الطريق المنحني .

وهي خطوط خيالية يرتب عليها المصور مثل الإشكال الهندسية أوالمثلث أوالدائرة أوحرف G ......الخ.

مثل شخص ينظر إلى اتجاه معين أو سيارة أو قطار يمشي في اتجاه محدد.

تكوين الصورة 
الفوتوغرافية

ويمكننا أن نصنف الخطوط الوهمية إلى ثلاثة أنواع:
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تكوين الصورة 
الفوتوغرافية

ثالثاً - الكتلة :

رابعاً - اللون :

المراد تصويره وتكون في مفرده مثل قمة جبل أو طائرة أو رأس شخص في لقطة قريبة  وهي حجم العنصر 
أومساحة كبيرة من الماء وتكون في مجموعة متقاربة أو متكاملة من الأشخاص أو العناصر تبدو جميعا في وحدة 

تكوينية واحدة.
انفصلت عن خلفيتها  إذا  قوة  الكتلة  وتزداد 
الكتلة  أما  واللون،  بالضوء  معها  بالتباين 
المكونة من مجموعة عناصر مختلفة فتزداد 
معا  مرتبطة  العناصر  هذه  كانت  كلما  قوة 
بعثرة  واحدة، كما يجب تجنب  في مجموعة 

المجموعات في الصورة.
ويجب تجنب تأثير الكتل اللونية فقد يودي 
من  كبيرة  مساحة  عن  الناتج  الغالب  اللون 
ضوء  من  الحمراء  أوالسحب  الأزرق  الظلال 
اشعة  انعكاس  او  الغروب  لحظة  الشمس 
الشمس الغروب على الماء الى تشتيت الكتلة 
تصويرها  المراد  الصورة  قوة  مركز  ونقل 

بسبب طيغان هذه الكتلة اللونية، ويجب الاستفادة من تاثير هذه الكتلة فيما يناسبها من أغراض .

الناس،فاللون  المختلفة ويشترك في فهمها معظم  الالوان  اليها  ترمز  ورموز معينة  وإيحاءات  هناك مدلولات 
والمعارك  والنار  للخطر  ويرمز  الحب  لون  وهو  الايجابية  الالوان  اكثر  أنه  على  الناس  عند معظم  يدل  الاحمر 

والثورة والدم والغضب .
أما اللون الاخضر فهو لون هادى مريح مجدد للنشاط ويوثر بشيء من السكينة في نفس يراه ، واللون الازرق  
لون السكون والهدوء، لون البحث عن الحقائق وهكذا لكل لون مدلول خاص يوثر في كل شخص يراه في صورة 
المعروف قد تم توزيعها في شكل دائرة  الطيف بترتيبها  الوان  بان  الفنان »مانسيل«  أجملها  وهناك علاقات 

سميت بدائرة »مانسيل« للالوان :

وهذه الألوان تتكون في أصلها من ثلاثة ألوان فقط هي:
.)  RGB (  أو ما يعرف اختصارا ب   BLUE والأزرق  GREEN  والأخضر  RED الأحمر 

ومنها توسعت درجات الألوان الفرعية المختلفة 
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3 - الألوان المتقاربة : 

1 - الألوان المتكاملة :

1 - مركز الاهتمام :

2 - الاتزان في الصورة الفوتوغرافية :

2 - الألوان المتناسقة أو المتناغمة : 

ائناء قيامنا بعمليات  ويمكننا إن نستفيد من تطبيقات دائرة مانسيل 
التصوير بمعرفة واستخدام خصائص ومميزات الألوان :

عند التقاط صورة فوتوغرافية فان من أهم جمالياتها إن تتميز بعدد من الخصائص مثل:

تسمى  وهذا  والأصفر  والبرتقالي  الأحمر  الألوان  وهي 
والأزرق  الأخضر  الألوان  بينما  المتقدمة  أو  الدافئة  الألوان 

والبنفسجي تسمى الألوان الباردة أو المتأخرة.

كل لونين متقابلين في دائرة مانسيل يمكن تكوين اللون الأبيض 
منهما لذلك فهما يعطيان تباينا ونقاء مثلا اللونان الأحمر والأخضر 
عند استعمالهما يعطيان أقوى تباين مثل لقطة زهرة حمراء صغيرة 

على خلفية خضراء هنا الألوان متساوية في مساحة  .

التي تلتقي عندها الخطوط  النقاط الأربع  أي تلجا إلى تقسيم الصورة إلى ثلاثة أجزاء بالطول بالعرض فتمثل 
نقطة قوية الناحية التكوينية .

لان المصور يستفيد من التوازن إثناء التصوير، كان لابد لك من إن تتعرف عليه فهو احد أجزاء جماليات تكوين 
الصورة،فعندما تتساوى القوى أو تكافئ كل منها الأخرى يقال عن الصورة أنها متوازنة .

مثلث  يصلها  ألوان  ثلاثة  كل  مانسيل  دائرة  في 
متساوي الأضلاع يعطي تأثيرا متناسقا في الصورة 
مثلا الأحمر والأصفر والأزرق تعطي تأثيرا متناسقا.     

تكوين الصورة 
الفوتوغرافية

جماليات التكوين في الصورة :
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تكوين الصورة 
الفوتوغرافية

1 - التوازن التقليدي : 

1 - المنظور الخطي :

2 - المنظور الهوائي :

2 - التوازن غير التقليدي : 

يلي  وفيما  المتماثل  غير  أو  التقليدي  غير  والتوازن  المتماثل  أو  التقليدي  التوازن  هما  التوازن  من  نوعان  هناك 
تفصيل لكل منهما:

وهو مظهرالاشياء كما يتحدد من خلال أوضاعها أو المسافات النسبية بينها ويوجد نوعان من المنظور .

التوازن تقليدي مثل كفتي  الجاذبية نحصل على  أو متساويين تقريبا في  التكوين متماثلين  عندما يكون جانبا 
ميزان متساويتين.

السكك  خطوط  مثل  المتوازنة  الأفقية  فالخطوط  تدريجا  المتوازنة  الخطوط  تقارب  إلى  الخطي  المنظور  يؤدي 
الحديدية تبدو كما لوكانت عند نقطة بعيدة في الأفق.

تأثير  للزرقة وهذا من  ابيض مائل  لو كان يغشاها ضباب  لونا كما  افتح  تبدو  البعيدة  المناظر  إن  ويتمثل في   
الأشعة نتجه الرطوبة والغبار في الجو وهو يعطي عمق في الصورة .

إذا وضعنا كتلة كبيرة ذات لون فاتح في ناحية من الصورة وفي الناحية الأخرى كتلة صغيرة ذات لون قاتم فان 
الصورة تعطي إحساسا بالتوازن وهذا التوازن يسمى  توازنا غير تقليدي اوتوازناً ديناميكياً.

أنواع التوازن :

المنظور :
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1 - اجعل الألوان الدافئة في مقدمة الصورة والباردة في الخلفية .
2 - الأسود والأبيض والرمادي لهم قيمة عظيمة في التصوير الملون فوجود الأبيض والأسود في الصورة يزيد من 

كمية التباين الظاهري.
3 - استعمل عددا قليلا من الألوان في الصورة لان هذا يعطيها قوة.

4 - استعمل لونا واحدا بدرجاته المختلفة في كل صورة .               

على المصور الفوتوغرافي إن يكون على دراية تامة بدلالاتها لتساعده في الحصول على تكوين ناجح للصورة .

تكوين الصورة 
الفوتوغرافية

واليك بعض المقترحات الواجب أتباعها بما يتعلق بالألوان إثناء التصوير :
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في تصميم المواقع
الأقل .. أفضل!!

 Minimal سنتحدث في هذا المقال عن تصميم المواقع البسيطة ، أو تصميم المواقع بالحد الأدنى من البساطة 
Web Design وهو منحى عالمي و خط خاص في مجال تصميم المواقع . له فلسفته و رؤيته ، البعض يعشقه ، و 

البعض الآخر لا يراه الخط الأفضل في مجال تصميم المواقع. 
و لكن دعونا نتحدث قليلًا عن هذا المنحى في عالم تصميم مواقع الويب :

 ،  Minimalism الأدنى  للحد  التبسيط  عالم  في 
يعتبر مبدأ “الأقل  أفضل” من أكثر المبادئ شهرة 
تصميم  على  حتى  ينطبق  الأمر  هذا  إحتراماً.  و 

المواقع تحت هذا المنحى . 
تصميم  في  المبدأ  هذا  تطبيق  يمكن  كيف  أما 
الضرورية  العناصر  الا  تضع  لا   ، فببساطة  المواقع 
أن  هو  هنا  الفكرة   . للتصميم  جداً  الضرورية  و 
استخدام الأقل سيكون له تأثير أفضل في توضيح 

المحتوى المطلوب إيصاله ، وهو الهدف .

ما   . مهمة  التفاصيل  كل  البسيطة  التصاميم  في 
ستعرضه في تصميم الموقع يمتلك أهمية قصوى: 
المساحات   ، الألوان  تدرج   ، للصور  الزاوية  شكل 
التصميم  في  جداً  مهم  يكون  شيء  كل   . البيضاء 

حينما تكون عناصر التصميم قليلة.
الذي تريد من تصميم موقعك  فكر في الإحساس 
التي  التفاصيل  بشأن  قرر  ثم   ، للزائر  يمنحه  أن 

ستولد هذا الإحساس. 
تعطي  التي  هي  الدقيقة  التفاصيل   ، النهاية  في 
التصميم هويته ، نعم سيكون التصميم بسيط جداً 
، لكن هل تريده تصميم بسيط و راقي ، أو بسيط 
و مرح ، أو بسيط و غامض ، هذه التفاصيل الدقيقة 
هي التي ستمنح تصميم الموقع روحه التي تريدها.

فكر فيما هو مهم للمحتوى الذي تقدمه أو للوظيفة 
الخاصة بموقعك ، ثم ركز فقط على هذه الأشياء و 
حاول أن تلغي أي شيء آخر لا يساهم بشكل مباشر 
في هذا المحتوى أو هذه الوظيفة بتصميم الموقع. 
على  ستؤثر  ستبقيها  التي  العناصر  هذه  أن  تذكر 
قابلية القراءة و قابلية الإستخدام لموقعك ، لذلك 

دعها فقط اذا كانت ضرورية.

في  “المتشدد”  المنهج  تسلك  أن  اخترت  حال  في 
التبسيط ، فحاول أن تختزل أي عنصر في التصميم 
، واصل بالإختزال حتى يتوقف التصميم عن تأدية 

الغرض منه ! 
التوقف  حافة  حتى  مختزلًا  تصميم  يكون  عندما 
عن العمل ، فأنت بذلك وصلت إلى تصميم بسيط 

بشدة . 
هذا المبدأ سلاح ذو حدين ، فتصميم الموقع يجب 
الإفراط في  و  للمستخدم  أن يحافظ على صداقته 
التبسيط قد يجعل التصميم غير قابل للإستخدام 
أو لا يكون ذو مظهر لطيف. لذلك وازن الأمور بحذر .

الأقل .. أفضل

كل التفاصيل مهمة

تنازل عن الأشياء الغير ضرورية

إختزل حتى النهاية

بقلم : نسمة قطان
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في تصميم المواقع
الأقل .. أفضل !!

بسيط  يكن  أن  يجب  الموقع  تصميم  فقط  ليس 
 ، الألوان  حتى  بل   ، العناصر  من  الأدنى  بالحد  و 
البساطة  شديدة  التصاميم  معظم  أن  تجد  لذلك 
)برأيي هذا  الأبيض فقط  و  الرمادي  اللونين  تأخذ 
و  المواقع(  ، قد لا يناسب كل  البساطة  تطرف في 
لكن بشكل عام ، كن حريصاً جداً على إختيار لائحة 
تصميم  في  ستستخدمها  التي   Palette الألوان 

الموقع.
جداً  خطير  عامل  تصبح  الألوان   ، التفاصيل  كما 
بسبب قلة العناصر ، لذلك أعطها إهتمامك و تأكد 

من تجانسها وتناغمها بالشكل الصحيح.

المساحة البيضاء في التصميم هي العمود الفقري 
في  أبيض  و  فارغ  تجعله  ما   ، التصميم  لبساطة 
 . التصميم  في  تضعه  ما  بقدر  مهم  التصميم 
العناصر  للتركيز على  جداً  البيضاء مهمة  المساحة 
المحيطة بها ، لذلك ركز على خلق مساحات بيضاء 

بكمية معقولة في تصميم الموقع.
عامة  مبادئ  مجرد  هو  ذكره  سبق  ما  كل   ، أخيراً 
للحد  )التبسيط  التصميم  مدارس  من  لمدرسة 
الأدنى( و لكن الذوق الشخصي يلعب دوراً كبيراً هنا 

، فما قد تراه مناسب قد لا يراه الآخرون كذلك .

هذا المقال منقول من عدة مصادر وليس جهد 
أو تأليف شخصي

لوّن بالحد الأدنى

المساحات البيضاء
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إنشاء قائمة منسدلة
Dreamwaver CS5 باستخدام

هل شاهدت يوما أحد المواقع التي تحوي قوائم منسدلة ... هل فكرت أن تنشئ قائمة منسدلة لموقعك الخاص .. 
إذا تابع معنا هذا المقال ... 

وستتمكن في نهايته من إنشاء القائمة الخاصة بك وضمها إلى موقعك.

 .... HTML , PHP )ونحدد بيئة العمل التي نريد العمل عليها )نوع الملف  New نختار  File من قائمة
لسهولة العمل نحدد طريقة العرض )Split( لنتمكن من رؤية الكود البرمجي ونافذة التصميم في نفس الوقت.

 Spry Menu Bar ثم Spry نختار  Insert أو من قائمة أفقية  )أزرار  القائمة  شكل  اختيار  الآن  يمكنك 
عمودية( .

بأسماء  الآزرار  من  مجموعة  على  حصلنا  والآن 
 …… , Item 1 , Item 2 : افتراضية إلى  تشير  رسالة  ستظهر  الملف  بحفظ  نقم  لم  إذا 

ضرورة حفظ الملف قبل إدراج القائمة 

بقلم : نسمة قطان
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إنشاء قائمة منسدلة
Dreamwaver CS5 باستخدام

ومن شريط الخصائص Properties تظهر خيارات 
التحكم بالقائمة ...

يمكنك في  شريط الخصائص تغيير اسم القائمة 
وعدد  والفرعية  الرئيسية  الأزرار  آسماء  وتغيير 

الأزرار لكل قائمة ..

القائمة  إضافة  بعد  الملف  بحفظ  القيام  عند 
ستظهر نافذة لتأكيد حفظ كافة الملفات الخاصة 

بالقائمة .

ربط  وهي  الأساسية  الخطوة  إلى  وصلنا  والآن 
الأزرار بالصفحات والروابط المناسبة لها 

مكان  لتحديد    Browse نضغط    Link جزء  من 
الارتباط ) ملف - صفحة ويب .... ( 

وتظهر القائمة بشكلها النهائي ...

وإلى اللقاء في موضوع جديد ... 
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http://creativesminds.wordpress.com/
https://www.facebook.com/creativesminds
https://twitter.com/CreativesMinds
http://www.youtube.com/creativesminds11
http://www.flickr.com/photos/creativesminds
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http://www.4shared.com/file/m8gRdYLm/Metals.html
http://www.4shared.com/zip/_MfH5ud6/12Black-grid-leather-and-metal.html
http://www.4shared.com/file/Hm2oAUEs/patterns-shop_damask_seamless_.html
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http://www.4shared.com/photo/hArAl2Ho/Clean_Web_Boxes.html
http://www.4shared.com/photo/H5P5fOjT/blank-black-tag.html
http://www.4shared.com/photo/fCm1EGyZ/psd-guarantee-seal.html
http://www.4shared.com/photo/ISYgQ-Cw/psd-blue-ribbon-rosette.html
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http://www.4shared.com/file/GW4cd6Rm/template_1.html
http://www.4shared.com/file/l_QDYMsy/template_2.html
http://www.4shared.com/file/dWnl4_9P/template_3.html
http://www.4shared.com/file/CLj6hVPD/template_4.html
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